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Release Notes Summary

9.10.0

9.10.0

Fixed Issues
e Fixed issue with Latin characters being added in the Chinese target when using the grid.
¢ Fixed issue with JSON Live Preview structure being off after some segment.

9.10.0

Known Issues

e MacOS: Issue with Catalina/Big Sur reporting keystroke logging during opening of application
e TXLF Editor column outlines get hidden when windows display settings are set to 125%



This section provides basic information to get started with Wordfast Pro, a stand-alone desktop application you
install on and access with your local computer.

Wordfast Pro is the latest standalone, multi-platform TM tool designed to address the needs of translators,
language service providers, and multi-national companies. It offers a complete translation environment that stores
your translated content for reuse on future projects, thereby maximizing efficiency, increasing overall consistency
and reducing translation costs.

Cross-platform compatibility — Browser-based tool runs natively on Windows, Mac, and Linux.

Target-only Live Preview — After translation, provides a preview to proofread a target-only version with
layout and formatting.

Segment filtering — Filters segments based on terms, regular expressions, match scores, notes, and other
attributes.

Configure multi-lingual translation projects — Supports translation into multiple target languages and can
send as a single package or separate packages based on language pairs.

Export and import translation packages — Allows configuration and export of translation packages for fast,
seamless translation management.

Format flexibility — Supports virtually any file format, including MS Office, Adobe InDesign, FrameMaker,
PDF, HTML, XML, SDL Trados Xliff, MemoQ XiIiff, and more.

Chain files — Allows combination of multiple files into a single file to improve the consistency of repeated
segments and facilitate file management.

Unlimited TM and glossary access — Accesses an unlimited number of TMs and glossaries simultaneously
and prioritizes as primary or secondary.

Activation of Wordfast Pro requires a license and online or offline registration.

An unlicensed version of Wordfast Pro working in Demo mode is limited.

e You can only create bilingual projects.

e You can only store up to 500 translation units (TUs) in a Translation Memory
(TM). To remove this restriction, purchase a license and activate the licensed
application.

To install Wordfast Pro:

1. Download the Wordfast Pro Windows Installer Package from http://www.wordfast.com/, based on your
operating system.

2. In your Downloads folder, double-click the .MSI, .DMG, or .TGZ file to open the Wordfast Pro Setup Wizard.


http://www.wordfast.com/

3. Complete all steps to align with your configuration, then click Finish.

Wordfast Pro opens in Demo mode. It still requires manual or online activation. Refer to Activation on page
9.

Activation

You can activate Wordfast Pro either manually or online. Both methods require an activation key. When you
purchase a Wordfast license, you can generate an activation key at https://www.wordfast.com/myaccount by
signing in with your sign in email and password. Copy and save the activation key.

To activate Wordfast Pro:

1. Open Wordfast Pro.

2. On the Sidebar, select the Open General icon to open the Wordfast Pro 5 application dialog.

3. Select Online Registration or Manual Registration, then follow the activation instructions.

About W Pleass snter your activation key and follow the instructions

Online Registration

License Type: Full, your license is activated
Manual Registration
Activation Key:

Update Wordfast Pro
. Licensawill expire in 324 days

-

Close
Option Description
Online Registration Enter the Activation Key, then select Activate.
Manual Registration a. Enter the Activation Key, then select Generate.

b. Copy the generated text into an email and send it
to the email address provided on the screen.

c. Save the license file from the return email.
d. Select Browse to the license file.
e. Select the license file, then select Activate.

After you activate the software, you can select either registration option to view the
number of days remaining on your license.



https://www.wordfast.com/myaccount

4. Restart Wordfast Pro.

The Wordfast Pro activation process is complete.

W=
To resolve any license issues, select the Open General icon j then select
Feedback.

Licensure

You can view license information after you have activated Wordfast Pro.

On the Sidebar, select the Open General icon 3 to view product information, your current license
information, Wordfast Pro update info, and to provide application feedback.

Wordfast Pro automatically monitors for updates. If an update is available, you receive
notification after you open the application.

About w About Wordfast Pro 5

Online Registration

Product Name: Wordfast Pro
Manual Registration
Version: 3.15.0.
Update Wordfast Pro
Build 1D: 20200124-1654
Feedback . -
JWM info: 11.0.5 {amded)
WIN 10.0
Copyright (c) Wordfast Pro, 2020. All rights reserved.
Privacy Policy
Close
Option Description
About Use to review product information, including your current version number.
Online Registration Use to activate your Wordfast Pro license online.

Manual Registration Use to manually activate your Wordfast Pro license through e-mail.




Option Description

Update Wordfast Pro Use to check for updates to the application and to add languages for the
application's Hunspell spelling dictionary.

Feedback Use to send feedback about software issues. Be as specific as possible, providing
the exact steps you took when the issue occurred. When sending feedback from the
Wordfast Pro desktop, the values from Name and Your Email are remembered and
saved after sending the report.
Please do not submit software usage questions to Feedback.

For software usage questions, select the Help icon to review the online help. If
you still have questions after reviewing the online help, sign in to your user account
at https://www.wordfast.com/myaccount and submit a Hotline request.

Start Wordfast Pro

After you install and activate Wordfast Pro, it is ready to use.
To start Wordfast Pro:

1. Double-click the Wordfast Pro icon on the desktop or select Wordfast Pro from the Windows Start menu.

W |: 1 |: ,,.,I |: | |: | |: | |: | |: 1 |=-" g E |§‘ IQ"
= 230 L@ LR Lo L3 e = T 4 oLl i
Open Create Open Close Add  Modify Remove Hecalculate Import Export Import SOL  Export SDL
TXLF Project Project Project Project Project Project  Progress Package Package Package Package
Projecis Location Source Language ~ ||| Target Language ~ || Date C... LastS... Comp... IE:]I 1 =
Wordfast Test C:\Users\Won  English German 2019/ 2019/.. 1%

. Quick Project  C:\Usersi\Won  English German 2019/ 2019/.. 5%
Another Test | C:\Users\Dest  English German 2019/ 2019/ . MNfA

Spanish {Latin Amet...
, Wordfast1 C:\Users\Won  English German 2019/... 2019/... MN/A

u German (Germany)
Wordfast_test C:\Users\Won  English German (Germany) 2019/... MN/A
Wordfast3 C:\Users\Won  English German 2019/... MN/A

—_—
-

4

Wordfast Pro opens to the Project List view.

2. (Optional) Select another view if you have created a project and are ready to begin translation or review.


https://www.wordfast.com/myaccount

2. Wordfast user interface overview

Wordfast Pro allows users to coordinate and automate the translation and review process through an intuitive,
stand-alone user interface.

Wordfast Pro uses a Sidebar to navigate among views. Click the icons to change from one view to another.

B F B R B B B BAE

Close  Recaloulate  GetMSWord ~ OpenSource  SwichEdior ~  Preview ~  SaveFileAs Save  Save As

Progress Table File Layout Translated
Source or Target - Match Case Regex |Enter text to fiter segments. ~ | Filter: | Select special fiter¢ ~ | Q@ 3 Sort:  Document )
D English (United States) German (Germany) Score Status
IVIOSU Ul US Tidve surre o1 o imoone

»

3 .
corporate email.

Assuming that you do, then the only time Unter der Annahme, dass Sie dies tun,
you should be using an OO0 message is if sollten Sie eine OOO-Nachricht nur dann
4 |you are completely unable to communicate verwenden, wenn Sie 3 Stunden oder langer
by email for 3 hours or more. nicht in der Lage sind, per E-Mail zu
kommunizieren.

s Jn » @

=_'—: 5 The following are good reasons to put up an Die folgenden Griinde sind gute Grande, eine

00O message: OO0O-Nachricht zu veréffentlichen:

6 | Trans-Atlantic Flight
On vacation in Laos or other such locale Im Urlaub in Laos oder einem anderen

7 |without significant wireless coverage ghnlichen Ort ohne nennenswerte WLAN-

Abdeckung
8 |Extended personal or medical leave
9 |Hiking the Appalachian Trail Wandern auf dem appalachian Trail

The following are not good reasons to put up
an 00O message:
11 Client Meeting

NN < N <

12| Dentist Appointment

« A —

4
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Sidebar Icon Action
Select to open the General view.
I""FI The General view includes general product information, as well as a form to

provide product Feedback.

In Wordfast Pro, you will also find product registration and software update
information here. See Activation on page 9 or Licensure on page 10 for more
information.

Select to open the Project List view.

Select to open the Current Project view.

Select to open the TXLF Editor view.

Select to open the Quick Tools view.

XRE>

_I—I- Select to open the Preferences view.

el o

<< Select to collapse the Sidebar. This action hides the icons and increases the
workspace.

Select E to expand the Sidebar.




The default view is the Project List view. ﬁ

When you begin working on a project from the project list, the result is the Current Project view. .

Each view is explained in more detail in the subsequent sections.

Project list view

The Project List view displays a list of your active projects.

Siclebar Action Button Action Bar Project List
W F\ w B R B B OE 7 =z e
i B L B T G B = T EI‘ P
Copen Crats DT 2 Add Remaows Recaleulats Import Irnpon SOL Export
TXLF Praoject Project F Project Project Project Progress Package Package Packane
| Projecis Location | Source Language = ||| Targef Language | ~ | Date Cr... | LastSa...| Complete| £3 |1 =
Quick Project C:\Users \We. English German 2019/0...  2019/1. 159
Wordfast Test  C:\Users\We.  English German 200%/0... 20191 | 8% |
Another Test C:\Usars'\De English Garman 2019/1 2019/1 . NfA |
Spanish [Latin Arnel
/ Wordfast1 C:\Users\We. English German 2019/0...  2019/0.. HJ/A
n Garman (Germany)
Wordfast_test  Cr\UsersiW English German {Germany) 201%/0 CNfA
Wordfast3 C:\Users \We. English German 2019/0.. N/A
—
] —
el
Item Action
Sidebar Click icons to switch among user views. User views include General application

information, Project List, Current Project, TXLF Editor, Quick Tools, and
Preferences.

Action Button

Perform a specific task.

Action Bar

Access all action buttons associated with a specific user view and tab.

Project List

View all files associated with a specific project.




Current project view

The Current Project view displays a list of the TXLF files that are included in a selected project. Double-click a
file from the list of TXLF files to open it in the TXLF Editor.

Collapsed
Sidebar Menu Tab Action Button Action Bar temsa
Project Fllegl Project TM Project Te: .
vel | B E [ — — =)
o B L2 A = = i,
Add Add Translate Open Source Cloze 5 Modify = Analyze -
Filez  Folders Files File Project Project Projec E
‘. Files 4 Wor TXLF File Location | Creation Date Last Saved Complete E} 1 =
~ mjien->DEg
| PD_en|de31.do 214 C:\Users\Wordfas 2019/09/09 13:2. 2019/09/26 11, 0%
E PD_en|de2.doc... 10 C:\Users\Wordfas...  2019/09/12 13:0... 2019/09/26 11... 0%
I8 Po_erl-de3d.. 214 # C\Users\Wordfes.. 2019/09/0% 13:1..  2019/10/04 10 [ 7% &
n" PD_eil-dedoc. 175 | Co\Users\Deskiop.. 2019/09/03 10:4..  2019/10/1509..  [ENES
—
] —
-
(1] - T 15% Transtata|i
Filz Languags File Lizt Froject File
Filter Pair Pragress Bar Progreas Bar
Item Action
Sidebar Select icons to switch among user views.
Menu Tab Access the various tools of the application. Each user view contains different

tabs.

Action Button

Perform a specific task.

Action Bar

Access all action buttons associated with a specific tab.

Collapsed Items

Access any remaining tools that do not fit in the window.

File Filter

Create filter criteria to refine the file list.

Language Pair

Access the file list associated with a specific source and target language pair.

File List

Access a specific file within the language pair.

Project Progress Bar

View the percentage of work completed on a project.




Item

Action

File Progress Bar

View the percentage of work completed on a file.

You can view file information, filter criteria, and sort files using the provided search options.

Files Word Count || TXLF File Location Creation Date Last Saved Complete

Item Action

Files Lists the files available in the current project. Type a file name in the box to
locate a file in the project list.

Word Count Displays the total word count of each file in the project.

TXLF File Location

Displays the directory path to the stored file location. Type a path name in the
box to locate a file or to group files in a particular path.

Creation Date

Displays the date and time the file was created based on the user's system
settings.

Last Saved

Displays the date and time of the most recently saved the file.

Complete

Displays the file progress bar with completion percentage.

Clears filter criteria.

Sorts filter criteria in ascending or descending order.

Change the sort order. The sort options are Files, Word Count, Translations
Status, Complete, and Last Saved.

The TXLF Editor view is your default translation and review workspace.

You can choose from two layouts for your TXLF Editor workspace.

e Table view—This layout displays the source segment to the left and the target segment to the right.

e Stacked view—This layout displays the source segment row directly above the target segment in a

spanned row.

You can select either layout view by selecting the drop-down menu for the Switch Editor Layout action on the

File tab.



File Name Action

Sidebar Tah Button
File
E

Close Recalculats Gat M3 Word

Progress

Tablhe

IMenu
Tab

Fibe

Open Source

Filter
Bar

Action
Bar

Table
Filter
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Preview
Pane
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Pane Column Column Pane Caolumn Column  State
Column
Item Action
Sidebar Select the icons to switch among user views.

File Name Tab

View an open or chained file.

Action Button

Perform a task.

Menu Tab

Access a specific function and its Action Buttons.

Filter Bar

Filter how segments are sorted and displayed.

Action Bar

Access all Action Buttons associated with a specific tab.

Table Filter

Create filter criteria for searching in the open file.

Collapsed Items

Access any remaining tools that do not fit in the window.

Preview Pane

View the translated content in its original format for MS Word .DOC
and .DOCX files, MS PowerPoint .PPT and .PPTX files, Markdown .MD
files, MS Excel .XLS and .XLSX files, or JSON .JSON files.

Editor Pane

Access editor tab content or interact with it using menus and sub-menus.




Item Action

Source Column View numbered text segments that will be translated in the Target Column.

Target Column Use as primary work area for translation entry with or without leveraging a
translation memory (TM).

Terminology Pane Search the source or target glossaries, or add terms to terminology
glossaries, if enabled.

Segment Score Column View the TM match score represented as a percentage.
Status Column View the status of a segment by its status icon.
Segment State Column View the state of the translated segment. Toggle between Needs

Translation and Translated.

Progress Bar View the progress of the total translation based on the number of
translated segments. If you have chained files, the percentage includes all
the segments in the chained file.

When the Preview, Editor, or Terminology panes are resized, Wordfast will remember
the settings the next time it is run.

Use filter criteria to narrow your search for segment content.

Source or Target Match Case Regex Fitter: Sort: | Decument
Option Action
Source or Target Select from drop-down menu to search source, and or target segments, or

user attributes.

Match Case Make your search case-sensitive.
Regex Select to search on regular expression or wild card characters.
Text Filter Filter segments based on text search.

Type or paste text into the text filter box and press Enter or select the

Filter »~ button.

Special Filters Select the drop-down list for more search filter criteria (listed below).

Activate the filter action.

Activate the cumulative filter action for all search fields.

Reset the toolbar filter fields.

Sort Select from drop-down menu to order the remaining search list.

Configure the maximum word count for the segment filter.




Special Filters are a drop-down list of all available search filter criteria:

100% match segments: segments matching completely in the TM

Aligned segments: segments that contains aligned score coming from aligner tool

All except 100% and Context match segments: segments with partial TM match, no match, or modified
segments

All except 100%, Context match and Auto-propagated segments: segments that are modified, fuzzy,
MT, no match, Align and Client provided scores

All except 100%, Context match and Translated segments: segments that are fuzzy, modified, MT, no
match, Align and Client provided scores with state Needs Translated Segments

All except 100%, Context match and Auto-propagated and Translated segments: segments that are
fuzzy, modified, MT, no match, Align and Client provided scores with state Needs Translated Segments
All except Duplicate segments: will show one instance of repeated segments

All except auto-propagated: all statuses except the segments that are auto-propagated

All except locked segments: all segments that are not locked

Auto-propagated segments: all auto-propagated matches

Client provided segments: segments provided by the client TM

Committed segments: segments with translated content committed to the TM

Context match segments: all 100+% context matches. Context matches provide more refined matches
that are based on contextual references in the TM. For example, a segment is considered a context match
when the previous and next segments also have a 100% match against the TM.

Do not write to TM segments: this is a status in editor to mark segments that should not be written to TM
Duplicate segments: segments being duplicated in the file

Edited 100% match segments: segments that contain 100% matches that are edited

Edited MT segments: MT segments that have been edited

Edited context match segments: segments that contain context matches that are edited

Edited fuzzy match segments: segments that contain fuzzy matches that are edited

Edited no match segments: segments that contain no matches that are edited

Edited source segments: source segments that have changed

Empty target segments: segments without a translated target

Excel Sheetname Segments: segments that contain sheetnames from an Excel file

First instance of Duplicate Segments: shows first instance of a segment that has more than one segment
with the same source

Fuzzy match segments: segments with partial TM match

Locked segments: segments that cannot be edited

Merged segments: segments that have been merged

Modified segments: all modified segments. By default all modified segments are highlighted in pink
Needs translation segments: untranslated segments

No match segments: segments with no match in the TM

Reviewed state segments: segments marked as reviewed

Segments merged across paragraph: segments have been merged across a paragraph
Segments with Transcheck warnings: segments with Transcheck warning status

Segments with history: segments that have been edited and has a segment revision history viewable in
the Segment History tab



e Segments with notes: segments containing comments

¢ Segments with find/replace highlight all: segments containing text highlighted by Highlight All from the
Find/replace dialog.

e Segments with repetitions: segments with repeated text strings

e Segments with tags: segments that contain tags

e Short segments: segments of fewer than {#} words, paragraphs or other blocks

e Signed off state segments: segments are signed off

¢ Split segments: segments that have been split into more than one segment due to length
e TU Autocorrected Segments: segments that have a target have replacement TUs applied
¢ Translated state segments: segments that have been translated

¢ Unedited MT segments: Machine Translated segments that are unedited

¢ Unique segments: segments that are not repeated

You can quickly identify the status of a segment in the TXLF Editor view by its status icon.

Status Icon Segment Status

A non-linguistic error occurred in the segment during a Transcheck test.

The segment is locked, so you cannot edit it.

The segment is do not write to TM, so you cannot commiit it to the translation memory.

The segment repeats more than once in the current file.

e | B

The segment has a note associated with it.

f‘ The content of the source segment was edited.
D', The segment was split.

A The segment was merged.

#n Segments across a paragraph were merged.

The Segment State allows you to view, set, or change the state of a translation segment in the TXLF Editor view.
Untranslated target segments are automatically set to Needs Translation. Once a translation is committed to the
translation memory, the application considers the translation to be complete and changes the state to Translated.
Changes to the Segment State will also change the total translation completed percentage on the Progress Bar.



Segment  Segment State Description
State Icon

Needs Translation — This state indicates that the segment is not finished and is therefore not
included in the calculated progress shown on the Progress Bar.

e All untranslated target segments are set to Needs Translation, or select Mark All Needs
Translation to change all segments to Need Translation. After translating the segment,
select this icon to change the state to Translated.

J e |If you commit a segment to the translation memory, or select Mark All Translated, this
state will automatically change to Translated.
e As you translate, you can commit the active segment to the TM by selecting the Next
Needs Translation Segment shortcut key (CTRL + Enter), and the active segment state
will change to Translated and then moves to the next segment whose status is set to
Needs Translation.

Translated — This state indicates that the segment is finished and is therefore included in the
Progress Bar. Select this icon, or make a change in the translated segment, to change the state
back to Needs Translation.

e Segments that are leveraged with Exact and Context matches are set to Translated by
default and are included in the Progress Bar percentage.”

e As you translate, when you commit segments to the TM by selecting Next Segment or its
shortcut key (ALT + DOWN), the segment state will change to Translated.**

* You can change this default setting on a project-by-project basis in Preferences.
= Select Translation Memory in the Current Project Preferences section. Clear or
check the preferred check boxes in the Segment state section.
Segment state
| Set segments to Translated with leveraged Context Matches
+| Set segments to Translated with leveraged 100%: Matches

| Set segments to Translated for Auto-propagated segments

**You can change the Next Segment action so that the segment state does not

= change to Translated. In Preferences, select Segment in the General Preferences
section. Clear the check box for Commit changes the segment state to Translated
in the Segment actions section.

Hons
W Mext/Previcus Segment action leverages nextiprevious segment

W] Commit changes the segment state to Translated

Progress bar



The TXLF Editor view displays translation information and status in the Progress Bar at the bottom of the

window.
. @ EM-UB — DE-DE Filtered Begments Totalk 6 | Tmnslated: B4% (22 wordsdons) | Segments 413 | Segient (BeiTlazi: N | Pamgraph (SmTythar): NI - 2% Imiznmmuhlll .
Item Description

Source and Target
Languages

View the source and the target languages in the open translation file.

Filtered Segments Total

View the number of filtered segments in the open translation file. When filter
criteria is cleared the Filtered Segments Total is removed from the status.

Translated

View the percentage of filtered segments that are translated versus the total
number of filtered segments in the open translation file. The words done total is
calculated from all the translated segments from the filtered table. When filter
criteria is cleared, the Translated % is removed from the status.

Segments

View the number of segments completed versus the total number of segments in
the open translation file.

Segment (Src/Tgt/Max)

View the character breakdown in a segment. This breakdown includes the
number of characters in the source and the target segments, and the maximum
number of characters allowed in the target. Hover over this portion of the toolbar
to view the progress in a larger display window.

A red box flashes around the Max segment value if the number of characters
exceeds the maximum allowed.

Segment [(Src/TgtMax): 646731

The maximum length check counts HTML entities such as: &. These are real
characters and are counted as part of the overall character count (1 Character per
entity). Refer to Manage tags on page 88 for more information.

Paragraph (Src/Tgt/Max)

View the character breakdown in a paragraph. This breakdown includes the
number of characters in the source and target paragraphs, and the maximum
number of characters allowed in the target paragraph. Hover over this portion of
the toolbar to view the progress in a larger display window.

A red box flashes around the Max segment value if the number of characters
exceeds the maximum allowed.

Paragraph (Src/Tgt/Max): 646731

If the maximum length is set for a paragraph and the paragraph has only one
segment then the maximum length limit is shown in the editor for a filtered editor
table.

Percent Translated

View the total progress of the translation in a file or in a group of chained files. If
you have chained files, the percentage complete will be the total for all the files as
if they were one.




Select the Help icon to access the online help for answers about how to use the software.

If you still have questions after reviewing the online help, sign in to your user account at https://
www.wordfast.com/myaccount and submit a Hotline request.

To send feedback about a software issue, select the Open General icon , then select Feedback. Be as
specific as possible, providing the exact steps you took when the issue occurred.

Please do not submit questions related to software usage to Feedback. Instead, sign in to your user account at
https://www.wordfast.com/myaccount and submit a Hotline request.


https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount

3. Manage projects

When Wordfast Pro opens, the default view is the Project List view. This view displays all your active translation
projects, and is where you manage the translation process for each project. On the Projects tab you can perform
many project operations, including creating projects, opening and closing projects, adding and removing projects,
and importing translation packages. After you create a project, you can keep a project on the projects list for

as long as it takes to complete it. A project stays in the projects list until you remove it. You can filter the list

of projects to display them by a variety of criteria including name, location, source or target language, and
completion percentage.

{ ™
a You can add a project to the projects list again, even after you remove it. Wordfast
does not erase removed projects, so you can retrieve them from the project folder on
your computer using the Add Project action.

\ Y,
e ™
a To bypass the typical project creation process, create a Quick Project with the Open
TXLF action.
\ J
Project Files Project TM Project Terminology Reports Reference Files 7 A X
B K6 E R B S B B _
Add Add Tranzkate 2 2N 5 = Close SAVE Modity E : Analyze Transcheck Segment Changes —
Files Folders File Files Fil= Project Project Project Expart Repaort Bepart
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- EN -> DE
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Open a TXLF file

A TXLF file contains text segments in a source language and a target language. In Wordfast Pro, to translate
the content in a TXLF file, you must create a project. A project may contain one TXLF file or multiple TXLF files.
This section describes how to create a Quick Project by opening existing TXLF files. To set up a new project and
prepare new TXLF files for translation, refer to Create a project on page 25.

To open a TXLF file:



1.

2.

Choose one of the following actions:

e Select the Project List icon ﬁ on the Sidebar to open the Project List view. Select Open TXLF, then
browse to select a file.

Projects

B B B EEBEREER F B8 B & R

Open Create Open Cloze Add Modify Remoaove Recalculate Import Export Import SDL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package

e Drag-and-drop one or more TXLF files to the project list.

If you used drag-and-drop, determine if you want to remember your choice on the Quick Open TXLF dialog,
then choose one of three possible actions.

Quick Open TXLF x

How would you like to open your TXLF files?
Nete: Quick Projects will not remain in the project list once closed.

Remember this choice

Open in New Project Open in Quick Project Cancel

a) (Optional) Select Remember this choice to use your selected option each time you choose the Quick
Open TXLF action without displaying the dialog again. Use General Preferences > General to show this
dialog again, after you choose to Remember this choice.

b) Select Open in New Project to use the standard Project Creation dialog.
c) Select Open in Quick Project to open the TXLF file in TXLF Editor as a temporary Quick Project.
d) Select Cancel to disregard the TXLF file open action and close the dialog.

If you chose to open the Quick Project, make your edits in the TXLF Editor, then save your changes and
select Close.

4. Select Save Project to retain the project in the project list.



5. In the Save Project dialog, modify the project details.

W Use this dialog to change the project name and set the location where the

project will be saved.

Project Name:" Quick Project

Save Project To:* C\sers'Documents'WFP\Resources Browse...

Save Cancel

Required fields are marked with a red asterisk.

a) Enter the Project Name.
b) Browse and select the file location in the Save Project To field.

c) Select Save.

Create a project

In Wordfast Pro, every translation begins with a project. Projects act as repositories for all related content, along
with associated translation memories (TMs) and glossaries.

G You must create a project before you begin translation, unless you use the Open
TXLF action.

6 A project also requires file format filters to convert the source content into segments
prior to beginning the translation process.

To create a project:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Click Create Project.
Project
D B EREBERER B BB A B B &

Open Create Open Close Add Modify Remove Recalculate Import Export Import SDOL  Export SDL
THLF Project Project Project Project Project Project Progress Package Package Package Package




3. On the Project Creation dialog, enter a project name.

Required fields are marked with a red asterisk.

Project Creation x
Project Name:™ Wordfastg Source Flles Reference Flles
Reuse Project: None - | (3] Add File E') Add Folder ? Create Filter Remove Files
Save Project To* Cr\UserswafWaordfastProlprojects Browse... Name Type Path
Source Language:” English (United States) -
Target Language(s):” Spanish (Mexico) X

[m]

Translatlon Memory Glossary Blocklist
= = = Ml .
= Create :0 Add =t Import odify Remove
Name Priority Read O... Type Path
Options

&/ Bun analysis repart on documents

Pre-translate TXLF files

Create Project Cancel

(Optional) If you want to reuse the profile of a previously created local project, select it from the Reuse Project
drop-down list.

Project reuse removes all existing translation memories, glossaries, and blocklists

from the new project. On the Reuse Project Warning dialog, click Yes to agree to
reuse the project.

Enter the Save Project To location or click Browse... to select the location for your project.

Select Source Language and Target Language(s) from the drop-down lists.

. You can refine the source language and target language drop-down list results by
= starting to type a language name.

On the Editor pane, click the Translation Memory tab, if it is not already active.
Translation Memory Glossary Blocklist

(= (= . - R

='IEE Create '.:'ﬂ Add =T Impaort odif 2 MOVE

Name Priority Read ... | Type Path



8.

10.

11.

(Optional) Click Create to add a new local TM for your project.
a) On the Create TM dialog, enter a unique name for the TM.
b) Select a target language to create a language pair, then select the location for the TM on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine the TM you leverage first.

You can select only one TM as the primary. The primary status dictates that the
content of that TM overrides any content in secondary TMs.

d) (Optional) To prevent any edits to the TM, select Read-only.
e) Click OK.

(Optional) To add an existing TM to your project, click Add, then select a local, remote, or a project-specific
TM from the drop-down menu.

. To use an online tool for work and production that integrates with Wordfast Pro, use
= Wordfast Anywhere (WFA) as your remote, unlimited, and private TM.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TM Server, WF Server, or WFA Server details on the Connect to Remote TM
dialog. Refer to Connect to a remote TM on page 109 .

¢) Add Project TMs — Enter the details on the Add Project TMs dialog by selecting the project.

The source language, target languages, and list of TMs auto-populate, based on the
project you select. Remove the target languages or TMs that you do not want to import
from the target languages and list of TM fields.

(Optional) To import an existing TM to your project, click Import.

a) On the Import Translation Memory dialog, select the import File Type: TMX or WF TXT TM format from
the File Type drop-down list.

b) Click Browse to locate and select the project file that contains the TM that you want to import.

c) Select either the Create a new TM or Import into existing TM option. Refer to Import a local TM on page
116.

d) If the TU already exists, select an overwrite option from the drop-down list.
e) Select Delete all TUs from existing TM if you want the import to overwrite and create a clean TM.
f) Click OK.

(Optional) To edit an existing TM in your project, click Modify.
a) On the Modify Local Translation Memory dialog, modify the name of the TM or its priority.

b) Select whether you want to protect the TM as read-only.



12.

13.

14.

15.

16.

17.

(Optional) On the Editor pane, click the Glossary tab.

Translation Memory Blocklist
Create D-I Add m Impaort
D o p
Name Read Only | Type Path

(Optional) Click Create to add a new local glossary for your project.

a) On the Create Glossary dialog, enter a unique name for the glossary.

b) Select a target language from the drop-down list, then select the location for the glossary on your local disk.
¢) If you want to prevent any edits to the glossary, select Read-only.

d) Click OK.

(Optional) To add an existing glossary to your project, click Add, then select a local, remote, or a project-
specific glossary from the drop-down list.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TMGR Server, WF Server, or WFA Server details on the Connect to Remote
Glossary dialog. Refer to Connect to a remote glossary on page 121.

c) Add Project Glossary — Enter the details on the Add Project Glossary dialog by selecting the project.

(Optional) To import an existing glossary to your project, click Import.
a) On the Import Glossary dialog, select the import File Type from the drop-down list: TBX or Tab delimited.
b) Click Browse to locate and select the project file that contains the glossaries that you want to import.

¢) To configure a glossary creation option, select either Create a new glossary or Import into existing
glossary. Refer to Import a local glossary on page 126.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing glossary if you want to ensure the import overwrites a clean
glossary.

f) Click OK.

(Optional) On the Editor pane, click the Blocklist tab.
Translation Memory Glossary
[?‘ Create ﬁ}ré Add ﬁ%‘ Import

Name Read Only | Type Path

(Optional) Click Create to create a new local blocklist for your project.

a) On the Create Blocklist dialog, enter a unique name for the blocklist.

b) Select a target language for the blocklist, then select the location for the blocklist on your local disk.
¢) If you want to prevent any edits to the blocklist, select Read-only.

d) Click OK.



18. (Optional) To add an existing blocklist to your project, click Add, then select a local or remote blocklist from the
drop-down list.

a) Add Local — Select a location on your local disk.
b) Add Remote — Enter the details on the Connect to Remote Blocklist dialog. Refer to Connect to a
remote blocklist on page 131.
19. (Optional) To import an existing blocklist to your project, click Import.
a) On the Import Blocklist dialog, select the import File Type: TXT.
b) Click Browse to locate and select the project file that contains the blocklist that you want to import.

c) Select the blocklist creation option: Create a new blocklist or Import into existing blocklist. Refer to
Import a local blocklist on page 134.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing Blocklist if you want to ensure the import overwrites a clean
blockilist.

f) Click OK.

20. On the Source Files tab, choose a method to add project source files.

Reference Files

Eﬂ?’-‘ Add File E; Add Folder ? Create Filter

Name Type Path

° You can drag-and-drop files from a folder to the Files panel.

° To copy source files into the Source File folder within the Project folder on your
computer, select Copy Source or TXLF Files into Project Folder Structure in your

General Preferences.
\. J

a) (Optional) Add File — Click to browse to the source file.
b) (Optional) Add Folder — Click to browse to the folder location for source files.

c) (Optional) Create Filter — Click to create a conversion filter the source files. You can create multiple filters.

21. (Optional) On the Reference Files tab, choose a method to add supporting documentation.

Source Files
!{I:' AddFile [ Add Folder
Name Type Path

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.



22. (Optional) Select any additional Options.
Run analysis report on  Analyzes source files against TMs and generates a report. You can also view this
documents report on the Reports tab, after opening the project.
Pre-translate TXLF files Populates TM leveraged segments when TXLF files are open.

Use primary MT onno  Leverages primary machine translation (MT) when there are no matches with the
match segments local and remote TMs. This option is only available if you selected Pre-translate
TXLF files.

23. Click Create Project to analyze the files and display the project creation summary.

Wordfast1 x

Here you can see the number of the files added, TMs,
®® hiocklists and glossaries along with any errors that might
have occurred.
Ea Bilingual (TXLF) Files
Created: 1
Failed: ]

..:\., Translation Memories
[~

Added: 1
D—l Glossaries
Added: 2
!{'} Reference Files
Added: 0
i Blocklists
Added: 2

~] Open created project

24. (Optional) On the Wordfast dialog, select Open created project.
25. Click OK.

The project is created.

Open a project

Once you create a project, the next step is to open it. You cannot open files for translation without first opening
the associated project.

To open a project:

1. Inthe Project List view, select a project name from the list.



2. Click Open Project or double-click the project name to open it.

RE R BEBRER B B 88 B &

Create Open Cloze Add Muodify Remove Recalculate Import Export Import SOL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package

The project opens in the Current Project view. A list of the project's language pairs and the associated
translation files displays on the Project Files tab.

Project Files Project TM Project Terminology Reporia Reference Files ? A X

Mew 2L & B RBBH & B B _
Ao Add Tranciate  Chain  Open Sourcs Clse Save Modity  Bllingua Analyze  Trangcheck  Sspment Changes =
Files Folders Filz Files Fil= Project Project Project Expaort Report Beport
ﬁ |Fil¢s | Wurd...l|TXLF File Location | Creation Date _ Complete ‘ Q1=
< EN -> DE
o [ sample-File_ . 183 Ci\Users\Public\WFP\Proje 2019/11/13 10: 0191113 10:.. [ |
n B sample-File_en.. 19 Ci\Users\Public\WFP\Proje..  2019/11/13 10:..  2019/11/13 10:.. [
o [ AdaptiveTrans.. 103 Ct\Users\Public\WFP\Proje...  2019/11/13 10:..  2019/11f13 10:.. | 0% |
n’ B samplez_sa.. 193 C:\Users\Public\WFP\Proje...  2019/11/13 10:..  2019/11/13 10:.. [ 18%
B sampleFile_en... 7 Ci\Users\Public\WFP\Proje...  2019/11/13 10:... S 5%
[ samples_sa_. 197 Ci\Users\Public\WFPYPreje...  2019/11/13 10:.. 19%
R

I-I-I
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4

EM — DE _ 24% Transiatzd

Modify a project
You can change the project name and target language using the Modify Project action.
To modify a project:

1. Inthe Project List view, select a project, then click Modify Project.

2R E R REBL R B B B B &

Open Create Open Cloze Add Muodify Remove Recalculate Import Export Import SOL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package




2. (Optional) On the Modify Project dialog, enter a different name in the Project Name field.

Modify Project x
e se this dialog to change the project name and either add or remove
target languages.
Project Mame:* Project1
Target Language(s):* German X
O
OK Cancel

3. (Optional) In the Target Language(s) field, add a language by selecting one from the drop-down list. Deselect
a language to remove it.

4. Click OK.

The modifications are active and the project list displays the changes.

Remove a project

To remove a project:

You can add a project to the Project List again, even after you removed it. Wordfast
Pro does not erase removed projects, so you can still retrieve them from the project
folder on your computer using the Add Project action.

1. Click the Project List icon m on the Sidebar to open the Project List view.

2. Select the project from the list, then click Remove Project.
Project
B B BEERB B R B B B & &

DOpen Create DOpen Close Add Modify Remave Recalculate Import Export Import SDL  Export SDL
THLF Project Project Project Project Project Project Progress Package Package Package Package



3. On the Remove dialog, click one of the action buttons.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 2
Reference Files 1
oK Cancel
Remove from the list only Remove the project from the Projects List but retain

project resources in the project folder on your computer.

Remove from the list and move the following Move the project TXLF, reference, and source files to
resources to Archive folder the Archive sub-folder within the project folder on your
computer.

4. Click OK.

The project is no longer in the Projects List.

Package files

A package file contains all of the required information to work on a translation project. You can use a package file
to share content and files among different Wordfast Pro (WFP) users. The package file can contain complete or
incomplete projects.

A package file generally includes:

e Source files

e All target translatable files

e [nstructions

e Background information

e Reference files

e Comments

e Connection to at least one Translation Memory (TM)
¢ Connection to at least one glossary and blocklist

To access a package file from another user, import the file into WFP. Wordfast connects the imported files to
translation memories and glossaries. It provides you access to all translatable files and additional resources,
including TMs and glossaries, without any additional setup or configuration.

To share a completed project with other users, export it as a package file.



Import package files

Package files allow different Wordfast Pro users to share files. When you import a package file, you automatically
connect the files to translation memories and glossaries. You also gain access to all translatable files and
additional resources. This eliminates the need for manually creating a project.

To import package files:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Click Import Package.
Proecs
2 B B B BE B B BT & B £ &

Open Create Open Close Add Modify Remave Recalculate Import Export Import SDL  Export SDL
THLF Project Project Project Project Project Project Progress Package Package Package Package

3. On the Import Package dialog, click Browse to locate and select the package file.

Required fields are marked with a red asterisk.

. Alternatively, you can drop a package file into the white space on the Import Package
= dialog to begin the import process.

e mport Package _ i
Select options to import a GLP file to the project list

Select a GLP file:” CUsers\rafDocuments\WWORKING-GloballinkW Browse...
Source Language: en-Us
Target Language(s): de-DE

* | Update an existing project
Select project to update:” Wordfast3 -
*) Only update the project's existing TXLF files

Update the project's existing TXLF files and add new files

Create a new project

~/| Open project after importing

Import Cancel




4. Choose one of the following:
e Update a project by clicking Update an existing project and its options.

e Create a new project by clicking Create a new project and its options. The project location drop-down

gives three options. The selected option is remembered the next time a package is imported.

o Create project in projects folder (Default): creates the project in the projects folder under the
WordfastPro directory.

o Create project in same location as the package: creates the project in the same location that the
package has been saved to.

o Enter the location to create the project: activates the Browse... button so that you can then
choose a location.

5. (Optional) Select Open project after importing to open the project in the Current Project view when the
import completes.

6. Click Import.

The package file is imported.

Export package files

Use Export Package to share a complete project package with other Wordfast Pro users.

To export package files:

1. Click the Project List icon ' l on the Sidebar to open the Project List view.

2. Select a project from the list of projects , then click Export Package.
Projects

2 B BF E B E B BF B & & &

Open Create Open Close Add Modify Remove Recalculate Import Export Import SDOL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package



3. On the Export Package dialog, select either Entire Project or Specific target languages and resources.

Export Package x
as Export Package
Select options to prepare a project export for distribution or archiving
Project Info
Project Mame: Project 1
Project Location: C\Users'WordfastPro\projecis\Project 1
Source Language: English
Export

*) Entire Project

Specific target languages and resources

Resources to Include in Export

Package Mame

Select Maming Convention: | Project Mame -

Preview: Project 1.glp

Select Location to Save

ChUsers\Documents\Source\WFP Export Browse...
Export Cancel
Entire Project Click to export all target languages and their associated resources.
Specific target a. Click to export specific target languages and associated resources.
languages and b. Click items from the drop-down list for further options to deselect specific
resources Target Language and resources for exclusion from the export.

4. Choose an existing name from the Select Naming Convention drop-down list or enter a name of your choice
in the Custom Name field.

The Preview field provides the name of the file as it will export below the Package
Name fields.

5. Select a save location for the project package, then click Export.

The exported project package is built and saved to the folder location.



Import SDL package files

You can import an SDL package file for conversion of SDL source files to a compatible Wordfast Pro format.
Imports include scores for source content, but do not include translation memories, glossaries, and reference files.

To import SDL package files:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Click Import SDL Package or drop the SDL Package file into the application window.

Projects
Open Create Open Close Add Modify Remave Hecalculate Import Export Import SDOL | Export SDL

TXLF Project Project Project Project Project Project Progress Package Package Package Package

3. On the Import Package dialog, click Browse to locate and select the SDL Package file.

c If the SDL Package file contains unsupported target languages, a warning message
notifies you. Click OK.

Import Package xX
e |mport SDL Package
Select options to import a package file to the project list
Select a package:* | C:Users\Desktop\Project 5.sdippx Browse...
Source Language: en-Us
Target Language(s): it-1T,de-DE

Create a new project

Project Name* | Project 5 |

Location:* | CUsers'Wordfastd\projects | Browse...

Open project after importing

Import Cancel

4. Enter the new Project Name.

5. Browse to and select the save location for the new project.



. (Optional) Select Open project after importing to automatically open the project in the Current Project view
after import. If this option is not selected, the project displays in the Project List view.

. Click Import.

The SDL Package file import completes.

Export SDL package files

Use Export SDL Package to export an SDL package.

To export package files:

. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

. Select a project from the list of projects, then click Export SDL Package.
projcts

Open Create Open Cloze Add Muodify Remove Recalculate Import Export Import SDL ~ Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package

. On the Export Package dialog, select the location of the original package and the location for the exported
package.

When exporting the SDL package, the Select original package: text box automatically
selects the file path of the original imported package file location based on the




previously used SDL package location. If the selected project was not imported from
the SDL package then the Select original package: text box will be blank.

Export Package x

-
e Export SDL Package
Select options to export SDL return package for projects containing SDLXLIFF files
Select original package:™ | ChUsers'WordfastPro\projects\Praject 1 | Browse...
Select refurn package location:™ |G:\Users‘.[lncumerﬂs\Soum&\WFP Export | Browse...

=l o

The exported project package is built and saved to the folder location.




4. Manage project files

When you open a project, the view changes to the Current Project view. On the Project Files tab, the language
pair of the project displays the list of translation files.

Project Files Project TM Project Terminology Reports Reference Files 2 A X
Wew 20 & BEBH 8 B B
Add Add Transiate hair en Sour Close Save Modity B 2 Analyze  Transcheck  Segment Changes =
Files Folders Fil= Files Fil= Project Project Project pairt Report Report
ﬁ |Filcs || Word... | TXLF Fie Location | Creation Date _ Complete a1 =
. EN -> DE
[y sample-File_ 188 C:\Users\Public\WFP\Proje 2019/11/13 10: 20191113 10: s 00
B sample-File_en.. 19 C:\Users\Publicl\WFP\Praje.. 2019/1y13 10:..  2009/1113 10:.  [ENEE
n AdaptiveTrans... 193 C:\Users\Public\WFP\Proje... 2019/11/13 10:... 2019/11/13 10:... | 0% |
n’ 5 sample2_sa_ 193 C:\Users\PubliclWFP\Proje..  2019/13/13 10: . 2019/11/13 10:. [ 18%
i B sampleFile_en.. 7 C\Users'\Public\WFP\Proje...  2019/11/13 10:_.. . 57%
“ [ samples_sa_ 197 C:\Users\PubliclWFPYProje.. 2019/11/13 10: 19%
R
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EN — DE _ 24% Translated

Add files

You can add files to an existing project using the Add Files option on the Project Files tab.

° If one or more of the source files have a different language code, you will receive a
prompt to modify the project and add the new target language.

To add files to a project:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Select a project from the project list, then click Open Project.

3. Click the Current Project icon - on the Sidebar to open the Current Project view.
4. Click Add Files on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

Bk B L0 B B B B £ €

Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Project Export Report

5. Browse to and select one or more source files on the Open dialog.

6. Click Open.



7. On the Files Report dialog, click OK.

Add a folder

You can add a folder containing multiple files to an existing project using the Add Folders option on the Project
Files tab.

To add a folder to a project:

1. Inthe Current Project view, click Add Folders on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

B E B b B B E BE B & E

Add Translale Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File: Files File Project Project Project Export Report

To activate the Current Project view, you must first open a project. Click the Project

List icon ‘ on the Sidebar and select a project from the Project List view, then

click the Current Project icon - .

. J
2. Browse to the folder, select it, then click Select Folder. During the import process, you might be asked to
define conversion filters for unknown file types.

3. View the statistics about the added files on the Files Report dialog, then click OK.

Open a source file

You can view a source file in its original format.
To open a source file:
1. Inthe Current Project view, select a file from the list, then click Open Source File.

Project Files Project TM Project Terminology Reports Reference Files

B B B [ B E E B BH

Add Translate Chain Open Source Close Save Modify Bilingual
Files Folders File Files File Project Project Project Export

2. View the source file when its default application opens.

e If the default application is not set, choose an application when prompted to do so.

Close a project

When you are finished working on a project, close it before you open another.



You can only have one project open at a time.

e In the Current Project view, click Close Project.
roece. |
2 B BE B B =

Open Create Open Close Add Modify
TXLF Project Project Project Project Project

Conduct a bilingual export

Use Bilingual Export to export the TXLF file with highlighted glossary terms into a .DOC or .DOCX format. This
allows you to edit and spell check the file using Microsoft Word, rather than the internal spell check.

You can also complete a bilingual export or import outside the Project List view using Quick Tools.

Bilingual exports require you to set Bilingual Export Options in Preferences >
General Preferences .

To conduct a bilingual export:

1. Inthe Current Project view, select a file, and click Bilingual Export on the Project Files tab.
Project Files Project TM Project Terminology Reporis Reference Files

B E B b B B E BE B & E

Add Translale Chain Open Source Close Save Modify Bilingual Analyze Tranzcheck
Files Folders File Files File Project Project Project Export Report

0 You cannot select files that are already open for bilingual export in TXLF Editor view.

2. Select the destination folder for the exported documents, then click Select Folder.

The session log is displayed. This log and the exported bilingual Word documents are saved in the selected
folder.

Log session start time Thu Sep 23 09:40:58 MDT 2021

Mumber of THLF files exported successfully: 1
Mumber of TXLF files exported with warnings 0

Mumber of TXLF file exports failed: a

INFC ToReviewhultiTxlf v1.17.0

INFO Bilingual Review Export

INFC Processing Co\Users\Downlosds\315_Batchi1 TR dem..QRG-En-Frls_fr-CA-Training_Excel-fr-CAZTR KE# xlsc bdf
INFC 145 tus written.




3. (Optional) Open the bilingual export report and review the results.

OFRT:Glo

OFRT:Glo

OmRT:Glo

OmRT:Glo

OmRT:Glo

From: Glossary
Sowrce: submission
Target: soumission
Glossary: TMGR

<FID»221f3lba—6074-4648-b856-835aeb6eB8564</FID> QRG-En—FrCa fr-CA-Training Exzcel-fr-
CRETR_XE¥ xlsx.txzlf
ID Source (en) Target (fir-ca) Score
1 Sheet] -
2 T30 Ezzentialz Fudiments de TS0 100%%
3 Cuick Reference Guide for TransStudio Guide de référence rapide pour 9%
Online TransStudio Online 3
4 Introduction Introduction 100%%
3 This document| provides users with Ce document| présente aux utilisatenrs les 100%
essential tasks associated with taches essentielles associées a TransStudio
TranzStudio Online (TS0 and assumes Online (TS0 et suppoze que vous
vou are already familiar with the interface | connaizsez d&)a I'interface ef les fonctions
and basic software finctions. de base du logiciel.
g Use the online help| for more details. Utilisez 1'aide en ligne| pour obtenir plus de 100%
détails.
7 Claim a Submiszion Demander une soumission 100%
8 Before you can access and u‘c_&r]c onyour [ Avant de pouveir zccéder a vos fichiers| et 100%
ﬁlﬂEL you must log in to Project les fraiter, vous deves vous connecter a
Darector| (PD) and use the FD Project Director| (FDY) et utiliser le tablean
das]l]ma:d|. de bord| de PD.

Analyze project files

Project analysis compares source files to a connected translation memory (TM) to leverage reusable content. Use

the Analyze action to assess files prior to translation or to pretranslate files.

To analyze project files:

1.

In the Current Project view, click Analyze on the Project Files tab.

Project Files

E
Add

Files

Project Terminology

Reports Reference Files

E 2 P B E E B B &
Add Translate Chain Open Source Close Save Modify Bilingual Analyze
Folders File Files File Projec Projec Project Export

OFRT-Glo
OFRT-Glo
OFRT-Glo
OFRT-Glo
OFRT-Glo
OFRT:Glo
OFRT:Glo

Transcheck
Report



2. On the Project Analyze dialog, select the language pairs and files for analysis.

Verify that the TXLF file you want to analyze is not open in TXLF Editor. You cannot
analyze an open file.

Project Analyze x
Project Files (1) Analysis Options
| Project Languages/Files Word Count | Pretranslate | 100 % | % matches and |Copy all tags on segments when t ~
v = EN -> DE DE Use primary MT on ng match segments
v = [l AdaptiveTranscheck.doox.bdf 532 Calculate analysis report percentage by: Words -

-

¥ | o matches

W Calculate internal fuzzy matches | 75
M| Include internal fuzzy matches with TM matches
Lock segments with 100% matches from being edited
Do not allow segments to be mernged
Do not allow sources to be edited
Ignare translated segments in from report
Ignore translated exact segments from report

Report Settings

*) Show only analysis report summary

Export Report

Translation Memory (2 )

./ | TM Name Location
~ <% EN-> DE DE S
™ ! German_DE C:\Users\Documents\So...
A AdantivaTranerhark o O\l lears\Ninrnmants) o h
Analyze Cancel
3. Select options below the Analysis Options heading.
Option Action
Pretranslate Select to create translated TXLF files, based on Pretranslate options.

Selecting Pretranslate is an optional step. The percentage defines the minimum
leverage required to pre-translate a specific segment.

¢ % matches—Select the percentage of matches to pre-translate from the
list.
e Select one of the following actions from the drop-down list:
o Copy all tags on segments when there is no TM match
o Copy segment source to target when there is no TM match
o Do nothing

e Select Use primary MT on no match segments to leverage machine
translation (MT) matches for all segments that do not have a TM match. If
you have TM matches, but do not select the TM before you click Analyze,
the MT overwrites all target segments.




Option Action

Calculate analysis Select an option from the drop-down menu to set the calculation percentage by
report percentage by either words or segments.

Calculate internal fuzzy Select to set the calculation percentage for internal partial matches, then

matches optionally select Include internal fuzzy matches with TM matches.

Lock segments with Select to prevent the edit of 100% matches and the overwrite of the TM with
100% matches from those edits.

being edited

Do not allow segments  Select to prevent the merging of translation units (TUs) during analysis.
to be merged

Do not allow sources to Select to prevent an overwrite of the source segment with new edits.
be edited

Ignore translated Do not consider target segments identified in the Analysis report.
segments from report

Ignore translated exact Do not consider exact match target segments identified in the Analysis report.
segments from report

4. Select the format for the output report below the Report Settings heading.
a) (Optional) Click Show only analysis report summary.

b) (Optional) Click Export Report, then complete the required fields and select a location.
5. Select a TM below the Translation Memory heading.
6. Click Analyze.
7. On the Report File dialog, view the project files analysis.

8. Click OK.

Run a transcheck report

Use a Transcheck Report to verify target segments and identify a variety of common errors within segments in the
translated files.

If you have specific terms you want Transcheck to ignore, you can mark those
= segments for exclusion in the Transcheck Report using the Transcheck All action. This
reduces false positives during Transcheck error detection.

To run a Transcheck Report:

1. Inthe Current Project view, click Transcheck Report on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

B B E £ b

1 Source Close Save Modify Bilingua Analyze Transcheck
Files Folders File es File Project Project Project Export Report



. On the Project Transcheck dialog, select one or more files.

Project Transcheck
Project Files (1) Transcheck Tests
) ) Configure desired check in Preferences » Transcheck
| Project Languages/Files Word Count
7 %% EN-= DEDE Report Settings
vl “ [ Transcheck.dooc.bdf 532 Reoart Name:"

Report Location:™ CAlzers\Documents\Source Browse...

Glossary (1) Blocklist (1)

| | Glossary Location

v/ =W EN-> DEDE

vl de-DE-TechDoc C:\Users\Documents...
Run Transcheck Cancel

. To select the Transcheck Tests you want to conduct, click the underlined Preferences > Transcheck path
name in Transcheck Tests. This link opens the Preferences dialog where you can configure the preferred
settings for each Transcheck.

{ )
0 Consistency checks are accessible through the Project Transcheck dialog. Or click

the Preferences icon 0= on the Sidebar, then click Transcheck under Current
Project Preferences.

a. Source Consistency — Use to search for segments with the same target
translation, but with different source segments.

b. Target Consistency — Use to search for segments with same source segments,
but with different target translations.

Select the appropriate check boxes to ignore differences such as case, numbers, tags,
and white space for source and target file consistency checks. Click OK to return to

the Project Transcheck dialog.
\ J

. Enter the Report Name and browse to select the Report Location folder, or accept the default settings.

. (Optional) If you want to enable the Glossary or Blocklist checks, select the location of the Glossary or
Blocklist from the list on each tab.



6. Click Run Transcheck.

Il

Report is optimized for Google Chrome, some features might not work well in your current browser.

Project TransCheck Report
Report Summary (1 files)

File Name Errars in file { = highlights)

PD_en-de.docx. tdf 0

Ignored Terminology Errors:

I;r'_'tr II Action “ Condition Ill';':l'r,-‘-', I

Highlight: & Exact Match B Fuzzy Match| B Exact (No Match)| [|Fuzzy (No Match)

| Toggle Global Search Filters | Global search filker is OFF

Project TransCheck Report - Wordfastl - English - German
Report Summary (1 file)

TransCheck ran successfully on 1 file and found 39 errors.
Target Consistency Check ran successfullr with 0 errors.
Source Consistency Check ran successfully with 0 errors.

Fila Mame Total Number of Errors

PD_en-de.docx. bxIf 29
PD_en-de.docx, txlf

Empty Target Check 0

Edited Source Check 0

Capitalization Check 0
FMunedited Fuzzy Check 11
edited Exact Check 3
Espelling Check 16
ElTag Check 5
Elwhitespace Check 4

Repeated Words Check 0

Unedited Fuzzy Check:

G 1-6-1 | ACCESS REAL-TIME DATA ZUGRIFF ALF 75% Target contains a

A Report Summary is saved to the chosen location. Once complete, a Transcheck report finished message
displays with the number of segment errors found, if any.

Generate a segment changes report

A Segment Changes Report provides you with the history of changes to a segment. You can run a Segment
Changes Report on one or more project files.

To generate a segment changes report:



In the Current Project view, select one or more project files from the list on the Project Files tab, then click
Segment Changes Report.
Project Files Project TM Project Terminology Reports Reference Files

BB 2 [ B BEEBEEREBSR B B

Translale Chain Open Source Close Save Modify  Analyze Transcheck Segment Changes
Files Folders File Files File Project Project Project Report Report

The Segment Changes Report button is removed when Hide MT as score is enabled
in the workflow for that specific phase.

2. Onthe Segment Changes Report dialog, select the languages or files to include in the report.

Project Files (3) Report Settings
-~/ Project Languages/Flles Word Count Show Columns:
Notes
M —ESENUS->FRCA
| QRG-En-FrCa.xlsx.tif 1571 ~/ Comments
M Bilingual table_fr-CA.docx.txIf 360 +/ Ratings
M Transcheck table_fr-CA.docx. tif 70 oot Bt Distance

v/ Segment State

~*| Enable Diff Highlight
Include "State’ only change segments in report
Show all segments (includes unmodified)
Show latest changes in each phase

Open report after export
* Filter Phase-name(s):

Filter Process-name(s):

Custom report name: Wordfast3 SegmentChangesReport 2023080871527

Report Location:* Browse...
Export Cancel
3. Select options from the Report Settings panel.
Option Action
Show Columns Select the columns you want displayed by clicking the appropriate check boxes.

Comments, ratings, and notes each have their own column. Blank columns
indicate the feature you selected is not available or there is no data related to that

option for the segment.

¢ Notes, Comments, and Ratings—Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.



Option

Action

¢ Post Edit Distance—Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions.

e Segment State—Displays the current and previous states of the segment
across linguistic and review phases.

Enable Diff Highlight

Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.

Include 'State’ only
change segments in
report

Select to show segments that have state only modifications in the Target
Revisions table.

Show all segments
(includes unmodified)

Select to download all segments in the Segment Changes Report, regardless of
any change to the target segment.

Show latest changes in
each phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Filter Phase-name(s)

Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list. You will need to select this option or the next one prior to
export.

Filter Process-name(s)

Filter content in the report by a specific process, such as No Review or Review
from the drop-down list. This option can be inclusive, so you can select several
processes. You will need to select this option or the one previous prior to export.

Include all phases
before selected phase-
name(s)

(Optional) Select this option to include all phases prior to the selected phase
name.

Custom Report Name

(Optional) Enter a unique name for the report if it requires customization.

Report Location

Browse and select the file location for saving the segment changes report.

4. Click Export.

5. Onthe Segment Changes Summary dialog, verify the names of the files you chose to include, then click OK.

Filename Segments Source segments ch... Target segments ch...
Wordfastl_Tran... 26 0 0
PD_en-de.doox 32 0 -
PD_en-de.docx 32 0 6

oK

6. Open the Segment Changes Report in a new browser window, then close the browser window when you are
done.



Generate an export notes report

The Notes Report contains all notes added to the bilingual project files. It can be exported to HTML or MS Word.

To generate an Export Notes Report:

1. Inthe Current Project view, click Export Notes Report on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

B w 2 L B &8 B B B

Translale Chain Open Source Analyze Transcheck Segment Changes Export Notes
Reporl Report

Files Folders File Files File Report

2. On the Export Notes Report dialog, select one or more project language files.

Export Notes Report x

Project Files {4 ) Report Settings
= | Project Languagea/Files | Word Count Export notes as:
B - EN-> DE Woard
%l i~ [ Po_en-de.docutdf 175 %) Him
[ . FO_en-ded.doocbdf 14 Report Location:” CAlsers\DeskiopWWF_Tesl_neports Browse...
=l i [ PO_en-dest.doc i 214
1% B PO_en-dez dooclbdf_de_notes.doc.bdf 10
Export Cancel

3. Browse and select the Report Location destination, then click Export.

4. On the Export Notes Summary dialog, click OK.

Filename Segments Segments with Notes
Sample_1.dooxl . teml bl f 37 3
sample_3.doocbml. td f 37 1
sample_2.dooxl . teml b 37 0

oK

The notes report saves to the specified location.

Clean up a project

After you have translated project files, you can clean them and update the translation memory (TM). The Clean
Up action converts the bilingual TXLF files into translated target files with the file format of the source.

To clean up the project and update the TM:



1. Inthe Current Project view, click Cleanup on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

BB B [ B &8 B B B E

Translate Chain Open Source | Analyze Transcheck Segment Changes Export Notes  Cleanup
Files Folders File Files File Report Report Report

2. On the Project Cleanup dialog, select a language or languages.

e Froject Clean Up
Select the options that you would like to use to write translated segments to TM and create translated files
Select languages fo cleanup Translated File Settings
(=) All Language Pairs -
Browse...
Create subfolders by language
Add language suffix to the translated file name
Single Language Pair
TM Overwrite Options:
Owerwrite exisfing TU -
Add attribute
Add file name as attribute
Owerwrite private TUs (WFServer TM only)
Select TM(s) fo Update
Symbolic Name Type Source Target Path
German_DE local en-Us de-DE C:\Users\lzielsdorf\Documents! So....
AdaptiveTranscheck-German local en de-DE C:\Users\lzielsdorf\Documents! So....
Clean Up Cancel
All Language Pairs Click to clean up all language pairs for the project.

Specific Language Pairs Click to clean up only the language pairs you specify from the drop-down list.

Single Language Pair Click to clean up only one language pair you select from the drop-down list.

3. Specify the location for the translated files from the drop-down list.
4. (Optional) Select Create subfolders by language.
5. (Optional) Select Add language suffix to the translated file name.

6. Select TM Overwrite Options from the drop-down list.



7. (Optional) Enable Add attribute, then enter that attribute in the attribute field.
8. (Optional) Enable Add file name as attribute to add the file name to the file attributes.

9. (Optional) Enable Overwrite private TUs (WFServer TM only) if you are connected to a Wordfast Server TM
and want to overwrite the private translation units (TU).

10. Select the TM(s) to Update from the table.
11. Click Clean Up.

All the options selected for the Project Cleanup dialog settings are remembered for the current project and will
not apply to other existing projects or new projects.

12. On the Info dialog, click OK.

When the cleaned files are saved at the designated location, a message displays indicating that the cleanup
finished successfully.

Remove a file

Use these steps to remove one or more files from a project.

You can add a removed file back into a current project. Retrieve removed files from
the project folder on your computer using the Add Files action.

To remove a file from a project:

1. In the Current Project view, select one or more files, then click Remove File(s) on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

Bw B2 I B B E F £ & B

Add Translate Chain Segment Changes Export Notes Cleanup  Recalculate Import Export Remove
Files Folders File Files Report Report Progress Package Package File(z)

2. On the Remove dialog, choose a removal option.

* Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 3
Source Files 7
4 3
0K Cancel
Remove from the list only Click to remove the selected files from the file list without moving

them to an Archive folder.



Remove from the list and move the Click to remove the selected files from the file list and to move

following resources to Archive folder them into a local Archive folder. When this option is selected, a
warning displays to alert you that this option physically moves
the files from their current project folder into an Archive folder.

3. Click OK.

The files are removed from the current project.



5. Manage submission files

Once you have a project set up in Wordfast Pro, you are ready to work with the files. Access the project files
from the Current Project view. When you open a TXLF file, the view switches to the TXLF Editor view. In the
TXLF Editor view, you can translate, review, temporarily combine files by chaining them together, and work with
translation memories and terminology lists.

Save a file

As you work on a file, frequently save your changes to a local folder.
To save a file:

1. Click the File tab, if you are not already on it, and then click the Save File as Translated, Save or Save As
button.

Translation Terminology Review

2 F 5 B B B B B B

Close Recalculate Get MS Word Open Source Switch Editor - Preview ¥ Save File As Save Save As
Progress Table File Layaout Translated

Save File As Translated Select to save the translated file to a local folder.
Save Select to save the .TXLF file to a local folder with the existing file name.

Save As Select to save the .TXLF file to a local folder under a different name.

A progress bar is displayed. After successful completion, the file is updated in a local folder.

2. (Optional) Continue with your translation or review. When you have finished, it is time to complete the file.

Chain files

To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating or
reviewing ten files with ten segments each, you can temporarily chain them into a single file of 100 segments.
Chaining files is particularly useful when working with duplicate or similar content among files.

You cannot export or save chained files as a single TXLF file.

You can open and work on a single chained file or multiple sets of chained files in the
TXLF Editor view. Each chained file displays on its own tab.

To chain files:



1. Inthe Current Project view, on the Project Files tab, select a set of files, then click Chain Files.

e Use Shift+Click to select sequential files or Ctri+Click to select individual files.

Project Files Project Terminology Reports

I Bw B B BRER & 8 B R B

Add Add Translate Chain Open Source Close Save Modify Analyze Transcheck Segment Changes Export Notes
H Files Folders File Files File Project Project Project Report Report Report

| Files | word¢ | TXLF Fie Location | creation Date _ Complete | <Iat

= EN US -> DE DE

452 C:\Users\bgraf\Documents\W. .. 2024/01/25 12:49:.. 2024/01/25 12:49... | [0 ]
183 C:\Users\bgraf\Documents\W. .. 2024/01/25 12:49:.. 2024/01/25 12:49... | [0 ]
3=
-y
EN-US — DE-DE 0% Translated

The chained file opens in the TXLF Editor.

0 To determine the related file name for a segment, hover over the segment ID.

Chained-Sampls-Document-2-MSWORD_TXLF-fr FRETR_VEWN# docx i *

|E‘rc}ume or Target - | Match Case Regex | Enter text to filter se

i:] Englich (United Statas)

For example, there is an image of the web accessibility
symbol to the left of this paragraph.

Its alternate text is "Web Access Symbol".

Alt text should communicate what an image means,
not how it looks.

23

1 |TRANSLATION MANAGEMENT. B
MADE SIMPLE.

LivePreview. Upload_1-MSWORD_TXLF--FRETR_VBWP# docx

WORK WITH MULTIPLE VENDORS
QUICK PROCESSING TIME

=R S S




2. Click a segment to make it the active segment.

The file name changes from the chained name to the source file name of the active segment.

Chainad-LivePreview.Upload_1-MSWORD_TXLF-frFRTR_VEWPZ.docxtxl  *

Source or Target - Match Caze Regex | Enter text to filter segments

D English (Unitsd Statss)

[ 1 UGG WAL 15 VYLD LLGS ST
Alt text should communicate what an image means, not
how it looks.

TRANSLATION MANAGEMENT. B

MADE SIMPLE.

STREAMLINE PROJECT MANAGEMENT

INTEGRATE WITH MANY SYSTEMS

WORK WITH MULTIPLE VENDORS

QUICK PROCESSING TIME

CUSTOMIZE WORKFLOWS

ACCESS REAL-TIME DATA

IGIobaILink Project Director saves millions of dollars

o~ | @ W=

3. From the File tab, click Save.

° If you need to review the files again, the chained files will open in the same order you
saved them.

The segments are saved in the chained file and restored to their original files without the chained format. The
progress for each individual file will show on the Progress tab.

Translate a file

. Save your work often by clicking Save on the File tab or by pressing Ctrl+S.

To translate a file:

1. On the Project Files tab, select a file, then click Translate File or double-click the file name to open it.

Project Files Project TM Project Terminology Reporis Reference Files a A~ X
2 B B L =z (B E B BH

Add Agd Translats Chain Open Source Close Save Modify Bilingual
Files Folders File Files File Project Project Project Export



2. Select a target segment and enter the translation. If you have a translation memory (TM) added to the project,
you can leverage translations from it.

*QRG-En-Freaxisx * N
Source or Target b Match Case Regex |Enter text to filter « | Filter Select sp - Q
|n] English (United States) French (Canada) Score Status
. ] ] _' 9704 Qf? E
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interface and basic
software functions. 9

3. Once you are satisfied with the translation, click Next Segment or Alt + Down Arrow. This action updates
the TM and moves to the next target segment. The segment state changes to Translated. Segments that are
changed to Translated are calculated on the Progress Bar at the bottom of the window.

Segments: 24/33 | Segment (Src/TgtMax): 11/28 | Paragraph (Src/TgbMax): 29/28/- _Ieft]l

o

0 As you translate, you can also commit the active segment to the TM by selecting
the Next Needs Translation Segment shortcut key (CTRL + Enter), and the active
segment state will change to Translated and then moves to the next segment whose
status is set to Needs Translation.

Translate segments

When you convert a file to a translatable format, all complete sentences become separate segments, often
divided by formatting or punctuation. Segments may be sentences, words, or numbers, depending on the
formatting of the source file. After you save the segment translations, the application commits the segment
translations to the translation memory (TM). Leveraging the TM automatically and consistently reduces the time
and expense of future translations by translating reoccurring words and phrases.

To facilitate rapid use of language-specific quotation marks, punctuation, and white
space, select Enable Smart Quotes in Preferences > General Preferences >
Segment .

You can choose from two layout views for your TXLF Editor workspace.



¢ Table view — This layout view displays the source segment to the left and the target segment to the right.

e Stacked view — This layout view displays the source segment row directly above the target segmentin a
spanned row.

You can select either layout view by clicking the drop-down list for the Switch Editor Layout action on the File

tab.
-
0 If there are either split or merged segments, indicated in the Status column with d
or ﬁ all split or merged rows within the spanned row have the same ID column color.
.
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Translate all segments

The Translate All option completes the translation of all segments by leveraging content in the connected TMs.

To translate a project file using Translate All:

1.
2.

In TXLF Editor view, click in a segment.

On the Translation Tab, click Translate All.

File Edit Formatting Translation Terminology Review

| Teminology _ Review
E BB RE B B BER B
Copy Copy

Mext Previous Commit Leverage Mark All Lintil Until Mo Tranzlats
Segment Segment Translated Source All Sources Fuzzy Maich All

This action leverages content in the connected TM and populates the target segments with translations. When
this process is complete, the screen refreshes and displays the results in the target column. The segment
states are all changed to Translated. The progress bar at the bottom of the user interface indicates the
percentage of translation complete.

EN — DE Segments: 2/2 | Segment (Src/TgtMax): WA | Paragraph (src/TotMax): N [ I00SaTransIated (Ooras et



View segment history

In TXLF Editor, view the record of segment changes to the open file on the Segment History tab of the Editor
pane. Changes to segments include segment updates, and lock actions.

TM Lookup Notes Segment History Metadata Tranzcheck (0) .
Type Value Score Modificati...
Target | Ayvant de travailler sur un fichier de 100+% 2018/0 «
. 8127
soumission, vous devez le 08570 .
demander. IMDT
Target |Avant de travailler sur un fichier de 2018/0
soumission, vous devez le 219
g g 13:25:2
emander. AMST
4 [ ]
EM — DE Segments: 99900 | Segment (Src/TgtMax): 76103/

Committothe TM

Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:

1. Inthe TXLF Editor view, choose one of the following:
e To commit a single segment to the TM, select a segment, then select Commit on the Translation tab.

e To commit all segments in the file to the TM, select Commit All on the Translation tab.

_ [=— = =" =
E B B B B S S g &

MNext Previous Commit Leverage Mark All - Copy - Commit Concordance Machine Analyze
Segment Segment Translated Source All Search Translation

2. (Optional) Verify that the updates you committed to the TM have a purple highlight.

The highlighted color can be selected in the General Preferences from the Colors
option by selecting the listed Committed into TM item.

3. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as
necessary until you have committed all translated segments to the TM.



Copy source content

To copy source content to the target:
1. In the TXLF Editor view, select a source segment.

2. To copy the source content, choose one of the following:
e On the Translation tab, select Copy Source.
e As a shortcut, press Alt+S to copy the source content.
3. Select a copy action from the resulting drop-down menu.

File Edit Formatting Translation Terminology Review

| Temminology  Review |
E B EBRE B B RR B
Copy

Mext Previous Commit Leverage Mark All - Copy Until Unriil No Translate

Segment Segment Translated Source All Sources Fuzzy Maich All
Option Action
Copy Source Select to copy from source all content and tags to the target.
Copy Source Text Select to copy only content from source to the target.
Copy Source, Tags and Term Select to copy from source to target all content text, its tags, and
Translations translated concordance glossary terms.
Copy Source and Term Select to copy from source to target all content text and translated
Translations concordance glossary terms.

Copy Source, Tags, Source and Select to copy from source to target all content text, its tags, and both
Target Terms source and translated concordance glossary terms.

Copy Source with Source and Select to copy all source and translated concordance glossary terms to
Target Terms the target.

The specified source content is copied to the selected target.

Copy all source segments

To copy all source segments to all target segments:

1. Inthe TXLF Editor view, on the Translation tab, click Copy All Sources.

File Edit Formatting Translation Terminology Review

| Temminology  Review
E B BR B B B DPR B

Mext Previous Commit Leverage Mark All Copy Lintil Until Mo Tranzlate
Segment Segment Translated Source All Sources Fuzzy Maich All

All source segments are copied to all segments in the target column.

2. (Optional) Begin translation in the target column.



Split or merge a segment

You can split or merge an existing segment to change segmentation. This is particularly useful for certain file
types or for languages where the next segment content may need to precede the previous segment. The best
time to split or merge a segment is early in the translation process.

To split or merge a segment:
1. Inthe TXLF Editor view, select the segment to split or merge.

2. On the Translation tab, select Merge or Split.

B BE B R B R BRE B B B
Copy

Mext Previous Caommit Leverage Mark All Merge Split Do Mot Write: Luu:kanbck' Clear
Segment Segment Translated Source ToTM Segment Target

The segment is merged or split and the segment Status column contains either the Merge icon ﬁ or

the Split icon d. respectively. If the merge includes an entire paragraph, this is denoted with the Merge

Paragraph icon .
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Lock a segment

You can lock a segment to prevent any further changes to that segment. The best time to lock a segment is when
the translation is complete and the reviewer has confirmed the content after proofreading it. The Commit action
still updates the translation memory (TM) with the target segment content.

To lock a segment:
1. Optionally, in the TXLF Editor view, use the table filter to filter out all unwanted segments.

2. In the TXLF Editor view, select the segment to lock.



3. On the Translation tab, select the Lock/Unlock Segment drop-down and select one of the two options:

o Lock/Unlock Segment locks or unlocks a single selected segment.

o Lock/Unlock All Segments locks or unlocks all segments. If the table filter was used to filter segments,
only the filtered segments are locked or unlocked. When Lock/Unlock All Segments is selected,
a warning dialog is displayed warning that all segments will be locked or unlocked; select Yes to
continue.

=

LockiUnlock
Segment

ﬂ Lock/Unlock Segment
IEE LockiUnlockAll Segments

The lock icon ﬂ is displayed in the segment Status column to indicate the segment or segments are locked.

Clear target segments

To clear target segments:
1. Inthe TXLF Editor view, select a target segment.

2. On the Translation tab, select Clear Target.

E B B B B REE B B B

Next Previous  Commit Leverage  Mark Al ~ Copy . Memge  Split DoMotWrite  LockMnlock . Clear
Segment Sepment Translated Source ToTM Segment Target

3. From the drop-down menu, select one of the following options:

e To clear the selected target segment, select Clear Target.

e To clear all target segments, select Clear All Targets.
4. On the Clear Current Segment Target dialog, select Yes to agree to the target content removal.

The target content is removed.

Do not write To TM

Translators or reviewers can use the Do Not Write To TM action to prevent a segment from being added to the
translation memory (TM).

To prevent a segment from being added to the TM:

1. In the TXLF Editor view, place your cursor in a translation segment..



2. On the Translation tab, select Do Not Write To TM, or press Alt + Enter.

Fie —cun_romanny_[RESSETS
E B B B B ID;DZE% B EB

Next Previous  Commit  Leverage  MarkAll T Merge Split DoMotWrite  LockMnlock . Clear
Segment Segment Translated Source To T Segment Target

The TM is not updated with the target segment content.

The % icon is displayed in the segment Status column.

3. (Optional) To later remove the restriction so the segment can be added to the TM, select Do Not Write To TM
again.

Find and replace content

Use Find/Replace to search for and replace text in translated content.
To find and replace content in a file:

1. Inthe TXLF Editor view, click the Edit tab.

2. Click Find/Replace.

E G Formatting  Translation  Terminology — Review 9 A X
ar c)G IE) Ij B B B B B M
Undo  Hedo Copy Find/  CopyAl ~  ClearAll ~  Edit  Revert  Show Whitespace

Replace Tags Tags Source Source Characters

3. On the Find/Replace dialog, click in the Find what field, then enter your search text or select it from the drop-
down list.

Find/Replace x

Q
Find what: |Iran5lati0n - |
A
A Reading Highlight ~  Find Next Close
Direction Options
Backward /| Ignore Case /| Search Source
*/ Forward Whole Words Only  + Search Target
Ignore NBSP /| Search Open Files
Use Regex

4. (Optional) Click the Expand icon ¥ to expand the panel for additional options, or click the Collapse icon # to
collapse the additional options.

Search text can include regular expressions (Regex), wild card characters, and non-
breaking spaces.




5. Click Find Next to move through all instances of the content.

6. (Optional) Click Reading Highlight and select the Highlight All action from the drop-down list to highlight all
instances of the content in all open files. Click Clear Highlighting to remove the highlighting from the previous
search.

Find/Replace x

Q
Find what: translation .
A
A Find Next Close
Direction ! Highlight Al F
Backward } Clear Highlighting || Search Source
*/ Forward | Whole Words Only  »| Search Target
Ignore NBSP /| Search Open Files
Use Regex

(Optional) You can filter table segments using the Segments with find/replace highlight all table filter to see
all segments containing text highlighted by Highlight All.

7. (Optional) To replace regular expressions, wild card characters, or words, click the Replace icon ™.. For
additional options, click the down arrow on the sidebar.

8. Click in the Replace with field and enter the replacement text.

Find/Replace x

Q FindNex:  |IETEEEER -]
u Replace with: -
A Replace Replace All  FInd Next Close
Direction Options
Backward /| Ignore Case /| Search Source
=/ Forward Whole Words Only  +| Search Target
Ignore NBSP | Search Open Files
Use Regex

9. (Optional) Select the direction of the search and any other options.

{ ™
You cannot use the Whole Words Only search option when entering multiple words

or punctuation in either search field.
\ J

(" ™
0 Select Use Regex to search on regular expressions or wild card characters.

\ J




10. (Optional) Click one of the following actions: Replace, Replace All, Find Next, or Close.

The content you found has been replaced with the new content.

Edit or revert source segments

Use Edit Source or Revert Source to edit or revert content in the Source column.

When the cursor is not on the source nor on the target segment then the Edit Source
and Revert Source buttons are disabled.

To edit content in the source segments:
1. In the TXLF Editor view, place your cursor onto the source segment you want to edit.

2. Select the Edit tab and then select Edit Source.

n Edlit Formatting Translation Terminology

xBoObE B B B EBE O

Cut Copy Paste Find / Copy All T ClearAl Edit Revert Show Whitespace
Replace Tags Tags Source Source Characters

3. Make edits to the source segment.

]
Editing the source adds the Edit Source status icon f to the Status column.

4. (Optional) To revert changes to the source segment, select Revert Source.

{ ™)
0 The Revert Source button is disabled when a source segment does not contain any
edited content.

0 Selecting Revert Source keeps the Edit Source status icon for the edited source and
also retains segment history of the source.

Spell check a file

You can use a spellchecker to verify translated content aligns with configured spell checking preferences. Refer to
Configure and enable spellchecker on page 190. You must verify that your Hunspell spelling dictionaries have
the latest updates. Refer to Licensure on page 10.

To spell check a file:



1. On the Review tab, click Spellcheck File.
=
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2. On the Spelling dialog, review the suggestions and select one of the options.

W Uses this pagse to check spslling.

Mot in Dictionary:

DICHTUNGSLOSE DATENBANKINTERGRATION Ignore Once

Ignore All

Add to Dictionary

Suggestions:
DATENBANKINTEGRATION Change
EINWAMNDERERGENERATION Change All
Preferences Cancel
Item Action
Ignore Once Click to disregard the suggested change for a word only once.
Ignore All Click to disregard the suggested change for all occurrences of a word in the file.

Add to Dictionary Click to add word to personal dictionary.

Change Click to accept the suggested change for a word.

Change All Click to accept the suggested change for all occurrences of a word in the file.

o If spell checking is not available for the target language, a warning message notifies
you. Click OK.

3. To view spell checking preferences, click Preferences or click Cancel to reject any changes.

4. Close the Spelling dialog.



Apply formatting

To apply formatting to the target:

1.

2.

Select text you want formatted in the target.

On the Formatting tab, select a formatting option or use the equivalent shortcut.

GO Translation  Terminology  Review

B I U Xa x? ABC = ) u a7 1« &
Bold ltalic Undesline Subscript Superscript Strikethrough Formatiing MNon-Formatting Hon-Ereaking Left To Right Right To Left Atach /
Tag Mode Tag Mode Spate Marker Marker Detach
Button Keyboard Shortcut Description
B Ctrl+B Format the selected text as bold.
Boid
I Ctri+l Format the selected text as italic.
Italic
U Ctrl+U Format the selected text as underlined.
Underline
X, Ctrl+= Format the selected text as subscript.
Subscript
x2 Ctrl+Shift+= Format the selected text as superscript.
Superscript
ABE Ctri+K Format the selected text to display as strikethrough
Strike (deleted), without actually deleting the text.
= No shortcut Display actual formatting associated with tags for the
Tag active segment (when supported.)
Formatting
e No shortcut Display the content of the formatting tags for the
active segment.
Tag

Mon-Formatting

— Ctrl+Shift+Space Insert a non-breaking space at the cursor location.
MNon-Breaking
Space
»qT No shortcut Insert a marker to indicate left-to-right reading
Left To Right direction.
Marker
q+ No shortcut Insert a marker to indicate right-to-left reading
Right To Left direction.

Marker




Button Keyboard Shortcut Description

& Ctrl+D Attach and detach the Formatting toolbar. When

Attach /

attached, the toolbar is displayed as a tab. When

Detach detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF

Editor.

3. (Optional) Select Non-formatting Tag Mode to show formatting tags or Formatting Tag Mode to hide

formatting tags.

Leverage auto-propagation

The purpose of auto-propagation is to apply translations to duplicate segments and re-use content. Configure and
enable your auto-propagation preferences under Preferences > General Preferences > Auto-Propagation.

To leverage repetitive content:

1. Select a segment for translation in the TXLF Editor. In this example, a filtered search locates and identifies

duplicate segments.

Source or Target o Match Case Regex |Enter lext lo filer segme ~ | Filter: | Duplicale segmenls

(0] English (United States) - French (Canada)

Before working on a submission file, you must claim it.

~| 0 L X sa)

Score Status

28 . o o 100+%
Avant de travailler sur un fichier de soumission, vous devez le
demander.
To modify how you receive PD notifications about your submission files,
refer to PD online help.
29 100+%

Pour modifier la fagon dont vous recevez des nofifications de PD
concernant vos fichiers de soumission, consultez l'aide en ligne de PD.

To modify how you receive PD notifications about your submission files,
30 refer to PD online help.
Pour modifier la fagon dont vous recevez des nofifications de PD

F

2. Enter the translation for the first target segment.

100+%%



3. To auto-propagate duplicate segments, choose one of the following actions:

o Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the
next segment from the TM.

e Click Commit or Commit All to commit one or all of the segments to the TM.

Once you commit the target segment, this action automatically propagates the TM updates to duplicate
segments throughout the file, based on segment preferences.

Source or Targel - Match Case Regex |Enter lexl lo filer segmeé ~ | Filter: | Duplicale segments - D ,C-' ¥ Sor 3
[14] English (United States) -> French (Canada) Score Status
Before working on a submission file, you must claim it.

28 100+%
Avant de travailler sur un fichier de soumission, vous devez le

demander.
To modify how you receive PD notifications about your submission files,

. refer to PD online help.
100+%
Pour modifier la fagon dont vous recevez des notifications de PD '
concernant vos fichiers de soumission, consultez 'aide en ligne de PD.

To modify how you receive PD notifications about your submission files,

30 refer to PD online help. 100+%
Pour modifier la fagon dont vous recevez des nofifications de PD =

F 5

Leverage auto-suggestion

You can use auto-suggestion to propose target content based on specific source content, such as numbers,
URLs, and proper names. You can also use auto-suggestion to propose terms for the glossary, machine
translation (MT), translation memory (TM) matches, and sub-segment TM matches. Configure and enable your
autosuggestion preferences under Preferences > General Preferences > Auto-Suggestion .

Monitor maximum segment length

Based on Project Director (PD) settings, your files may have a set maximum segment length. Any violation of
a segment that exceeds the maximum characters allowed results in a change to the segment Max value in the
progress bar from black to red and is indicated by a flashing red box appearing around this value.

Users can monitor the progress bar for maximum segment length violations, and can also configure the
Transcheck Report to flag such violations.

Recalculate the progress of a file

Use Recalculate Progress to calculate and update the progress of translated files and word count, especially
files created or edited in legacy versions. When you open a legacy file, the progress bar contains the N/A flag to
denote that it will not calculate progress.



o Refer to Chain files on page 54 to recalculate progress of multiple files.

To recalculate the progress of a file:

1. On the File tab, click Recalculate Progress.

2. Review the progress bar for current file status.

The progress bar is updated to display the % Complete status of the file.

Get an MS Word table

You can preview and save the file you have open for translation as a bilingual table in MS Word format.
To get an MS Word table:

1. Inthe TXLF Editor view, select a file with translated content.

2. (Optionally) In the TXLF Editor view, use the table filter to filter out any unwanted segments.

3. On the File tab, select Get MS Word Table.

Edit Formatting Tranglation Terminology Review

B B B B B B B B B

Close Recalculate Get MS Word Open Source Switch Editor  © Preview Preview Save File As Save Save As
Progress Table File Layout File Translated

4. On the Get MS Word Table dialog, select Get MS Word Table.

0 You can configure MS Word Table settings by clicking the hyperlink to the
Preferences location. If you want to disable the dialog, select Don't show this
dialog anymore. If you need to re-enable the warning dialog, select Show dialog to
configure MS Word Table Preferences from General Preferences > Warnings.

Get M5 Word Table x

Configure M3 Word Table in: Preferences > General > Get MS Word Table Options

Don't show this dialog anymore

Get MS Word Table Cancel




5.

If the segments were filtered, an Export Segments To MS Table dialog will appear. Select Continue to export
only the filtered segments to the MS Word table.

Selecting Cancel will export all the segments to the MS Word table document
regardless of any segment filter applied.

Export Segments To MS Table 3

o Filtered segments will be exported! Click Continue to get filtered

result or Cancel to get entire document?

Continue Cancel

The file downloads as a Microsoft Word document containing a bilingual table of source and target segments.
The target locale code is added to the file name for the generated word document.

O =

b B s word preview_b68843820352945809034_fr-CAdoc [Compatibility Mo...

HOME = INSERT DESIGN  PAGELAYOUT  REFERENCES MAILNGS  REVIEW  VIEW -
2 Times Mew Roman  =[12 = |:(=-i=~-"-- & 3= )&J # I
Paste L U7k x x ‘i}*_ - = & St:Tes Editing|  Manual
. W-A-ha- | AN | DT - = | Classification
Clipboard = Fant f Paragraph L | Styles = Data Protection -

WARNING: Modifications done to this document cannot be imported back into Wordfast

QRG-En-FrCa.xlsx.ixlf

6. (Optional) Review the resulting file for completeness.

Preview a file

Use Preview to display the source content in its original format, such as MS Office, HTML, and Markdown source

formats.

1D English (United States) French (Canada) Score

1 Sheetl

2 TSO Essentials Rudiments de TSO 100

3 Quick Reference Guide for Guide de référence rapide pour 97
TransStudio Online TransStudio Online 5

4 Introduction Introduction 100

5 This document provides users with Ce document présente aux 100
essential tasks associated with utilisateurs les tiches essentielles
TransStudio Online (TSO) and associées 4 TransStudio Online




To preview files:
1. Open afile in the TXLF Editor view.

2. On the File tab, click Preview, then select a preview type on the drop-down list.

File i Formatting Translation Terminology Review

B F H B B R B A B

Close Recalculate Get MS Word Open Source Switch Editor Preview Save File As Save Save As
Progress Table File Layaout Translated

The preview of the source content is displayed in its original format.

Use Live preview

Using Live Preview you can generate a dynamic preview of a translated file in its original format for the following
file types:

e MS Word .DOC and .DOCX files

e MS Word .DOCX files, converted from PDFs

e MS PowerPoint .PPT and .PPTX files

e Markdown .MD files

e JSON .JSON files

e MS Excel .XLS and .XLSX files

o Preview is disabled for multilingual target Excel files.

Live Preview is enabled by default in the TXLF Editor view. To enable or disable automatic opening of Live
Preview, go to General Preferences > General, and select or deselect Automatically open Live Preview for
supported files.

To collapse or expand the live preview pane, click the Collapse icon Ed or the Expand icon & located on the top-
right of the TXLF Editor view.

To zoom in or out of the live preview pane, select a percentage in the zoom drop-down list [ 100% =,
To generate a Live Preview:

1. Open a file in the TXLF Editor view.



2. On the File tab, select Live Preview from the Preview drop-down menu.

0 Only one preview option is possible at a time.

Translation Terminology Review
2 F 2 B R B B
=) : B i o B =
-
Close RBecalculats Get M5 Word Open Source Switch Editor Preview Save Filz Az Save Save Az
Progress Table File Layout Translated

3. (Optional) Interact with the Live Preview of the file.

For MS Word files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

ﬂ. Live Preview highlights the active segment. Move to any other segment by clicking on that area of the
Live Preview.

[l B rormameg Tressisten  Tersieclogy  Feview m ByraPrevies 3 ¢ ¥
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e Chiobadlmik Comneot wilh gy TV, PIML COMS, el genen
o e-comumerre plationy or tramlat
VENDOR NEUTRAL FLATFORM CONFIG
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Excel documents display spreadsheets. Multiple sheets appear at the bottom of the live preview pane.
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

ﬂ. Live Preview highlights the active segment. Move to any other segment by clicking on that area of the

Live Preview.
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For MS PowerPoint files
PowerPoint files can be graphically intensive and may take time to load. The progress bar provides real-time

loading status. Select the View All Slides box to load the entire document. Click the cancel icon * to cancel
the Live Preview.

e Terminology  Review A X

Docking—The live preview pane docks to the right. For docking options, click the live preview panel's

Settings icon: n Live Preview highlights the active segment. Move to any other segment by
clicking that area of the Live Preview.

Slide Access—Click the forward or back arrow to progress through the slide deck or type the deck
slide number in the Slide field. While in the editor, move back to the slide that correlates to the open

segment by clicking the Target icon: E

'i + 2 o Transstudio review (tsr) vs. Jtranslation review portal (trp)
et Previous MascAll Copy = |—
Segment Sagment Translated Source

TSR ve. TRP.pptx ¥

D

Fa

Source or Targed batch Cass Regex |Enter text to 1 ~ | Filter: | Selec | J

English (United States) French (Canada) = Score Status

1 title | =
2 [January 2018 o
Transstudio review
3 [{tsr) vs. [@itranslation o
review portal (trp)
4 |Side by side views vy K" | .
5 |Benefits of tsr o ZF tranSIatlonS C
6 FOR SUBMITTERS o E
LAMGL INOILOK I I RGO 1

Selecting your
reviewers or allowing
multicle reviewers to

For Markdown files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

n. Live Preview highlights the active segment. Move to any other segment by clicking on that area of the
Live Preview.
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For JSON files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

ﬂ. Live Preview highlights the active segment. Move to any other segment by clicking on that area of the
Live Preview.
For JSON files, Live Preview shows the translatable text in bold and at a larger font size.

File Edit Formatting Translation Terminology Review ? A X Sync Preview 'ﬂ' - )
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4. (Optional) Enter the translation or leverage the TM for any segment.



5. (Optional) On the Translation tab, click Next Segment or press Alt+Down Arrow to update the TM, move
down one segment, and leverage the next segment from the TM.

The new translation is displayed.

6. (Optional) Click Sync Preview to refresh the preview.

Use Office preview

The Office Preview option allows you to generate a static preview of MS Office documents using the target
segments in your translation.

G If the MS Office file type you select can be opened in a Live Preview, this option is
shown, if not you see only the Office Preview option.

To generate an Office Preview:
1. Open afile in the TXLF Editor view.

2. On the File tab, select Office Preview from the Preview drop-down menu.

Edit Formatting Translation Terminology Review Simple View 7 A X

"k P R M E B B B

Close Close All Recalculate Save Save All Finizh - Get M5 Word  Download Download  Switch Editor Preview -
Progress Review Table Reference Files Source Files Layout @ Live Breview

x
Sample-File_en-de.docx E; Office Preview

3. (Optional) Interact with the newly opened Office Preview window. If you make changes to the target segments
and wish to view those changes, just select Office Preview again and a new preview is generated.

Use HTML preview

If you are working with an HTML submission, the translated document can be viewed using the HTML Preview.
To generate the HTML Preview:
1. Open an HTML file in the TXLF Editor view.
2. On the File tab, select HTML Preview from the Preview drop-down menu.
ZSMl Edit Formatting Translation  Terminology  Review

ER E BR B BB B B

Close Close All Recalculate Save Save All Switch Editor - Complete Complete  GetMS Word Download F‘rmrina'.'.."Ir
Progress Layout All Table Source Files

*basic_htm.htm [ Htmil Preview

3. A new window opens and displays target content in context. To view new changes to target segments in
a translated view, select HTML Preview again and a new window with the updated translated document
generates.



Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.

Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions, or no match. Your organization may choose to
alter or add more fuzzy repetition categories. The typical fuzzy repetition values are for 95% to 75% matches. The
segment highlight identifies the type of TM match.

Color Code Category
Green Indicates a 100% match.
Green, Dark Indicates a context match. A context match for a segment must meet one of the
following criteria:
e The segment has a correct checksum or attribute match.
e The previous and next segments also have a 100% match.
e The 100% matched segment is a single paragraph.
Grey Indicates there is no TM match.
Pink Indicates a modified segment.

Orange, Light

Indicates the segment was a machine translation (MT) instead of a human translation.

Purple Indicates an update to the TM for a modified segment.

Purple, Light Indicates the update to the TM of a translated and committed segment automatically
updates other repetitive segments within the translation.

Yellow Indicates a fuzzy match.




Leveraging a segment involves selecting the best possible translation from the connected translation memories
(TMs) or machine translation engines to populate target segments.

To leverage a TM:
1. In the TXLF Editor view, select the segments to leverage against the current TM.

2. On the Translation tab, select an action to leverage the current TM.

Leverage Select to leverage a single segment.
Until Fuzzy Select to leverage segment content until reaching a fuzzy match.
Until No Match Select to leverage segment content until there is no match.

Translate All Select to leverage all content in all segments.

A translation memory (TM) lookup or concordance search looks for specific source segment text in a translation
memory. To view search results for both source and target segments, use the TM Lookup tab in the Editor pane.

To conduct a TM lookup or concordance search:



1. Search for a word or phrase by entering it in the TM Lookup field. Then, to conduct a search of both source
and target, press Enter. Instances of the search term are highlighted in the Editor pane, along with its bilingual
equivalents. To conduct a more specific search, click Find Source or Find Target.

(" ™
0 You can also select a word or phrase in the segment in the TXLF Editor view and
then click Concordance Search from the Translation tab, or press F8.

e Instances of the search term are highlighted in the Editor pane, along with its bilingual
equivalents. To conduct a more specific search, click Find Source or Find Target.

° You can reorder the columns of the TM Lookup results. That reorganization remains,
even after you exit the software.

TM Loockup  Notes  SegmentHistory  Metadata  Transcheck (0)

submission More Options =  Find Source Find Target Cle
# | Source Target Score | TM Name Last Modified  Custor
1 BCreate B> Création d'une - ™ 2019/12/17 A
MST
2  Submission Modéle de soumission - ™ 20191217
Template Server 07:16:22
MST
3 | Save Submission |Enregistrez la soumission. - TM 201912117
Sarvar N7-18-272 N
4 >
2. (Optional) To refine the search, select More Options and select a check box from the drop-down list.
Option Action
Match Case Select to filter by upper and lower case.
Exact Select to filter for only those terms organized in the same sequential order.
Automatic Leverage Select to automatically update target content when moving to a new segment.
Diff Highlight Select to highlight the difference between the submitted segment and the TM

source segment.

Include Private TU (GLTMS) Select to include private segments or translation units (TUs) when searching
a remote TM.

The refined search results for the word or phrase you selected are listed on the TM Lookup tab of the Editor
pane. You can use the results of your search in the related target segments.

View TM leverage results



Leveraging the translation memory (TM) occurs automatically as you move through the target segments. This
provides you with the best possible segment matches from the TM and is the only search that uses scoring to

select the best match.

To view TM leverage results:

1. Inthe TXLF Editor view, click on a source or target segment.

This populates the columns on the TM Lookup tab of the Editor pane and provides a score, based on TM

leverage results.

TM Lookup Notes

# | Source

1 | SIMPLIFIED.

, | SIMPLIFIEDI
phified

5 | SIMPLIFIED.
Simplified:

, SIMPLIFIEDHE
Simplified:

5 | SIMPLIFIED.

Segment History

Metadata Transcheck (0)

More Options =  Find Source Find Target Clear

Target Score TM Name Last Modified Custom Attribute
VEREINFACHT. | 100% Doc_ TM2 | 2015/11/04 ()]
mit minimalstem | 999, Doc_TM2 | 2013/04/26 ®
Aufwand
Vereinfacht. 0%, Doc TM2 | 2014/03/14 ®

Vereinfacht. 0%, Doc TM2 | 2014/11/07 ®
VEREINFACHT. | 100+%*  Doc TM1 | 2017/04/04 @

2. Review TM leverage results in each TM Lookup column for that segment.

Item Behavior
Source Displays source segments provided by the TM. Any difference between the submitted
segment and the TM source segment is highlighted.
Target Displays target segments already in the TM.
Score Displays a TM leverage score.
e Percent (%) — 100% and fuzzy matches
e Plus (+) — Context matches
e Asterisk (*) — Secondary TM match
¢ Red outline — TM has assessed a penalty to the segment
Refer to Translation memory on page 77 for more information on TM color codes.
TM Name Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the

TMs in order of priority: primary, then secondary TMs.

Creation Date

Identifies the TM segment creation date.

Creation User

Identifies the username of the segment creator.

Last Modified

Identifies the date of the last segment modification.

Modification User

Identifies the user who last modified the segment.

Custom Attribute

Identifies any segment custom attribute name and its associated values

Actions

Acts as a button to access score breakdown information, including penalties.



3.

Item Behavior

®

(Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the
columns you want to hide.

TM Lookup Notes Segment History Metadata Transcheck (0)

- More Options =  Find Source Find Target Clear
# Source * Target Score L TM Name Last Modified
5 | SIMPLIFIED. 1 SortAscending | (/1 4 | | Doc_TM1 | 2017/04/06
1 | SIMPLIFIED. | ¥ SertDescendng | 1 source Doc_TM2 | 2015/11/04
3 SIMPLIFIED (SRR | oo j;: | Doc_TM2 | 2014/03/14
4 | SIMPUIFIED SESEEENEEE | Vercinfacht &/ ™name | | Doc_TM2 | 2014/11/07
,  SIMPLIFIED Fiiied mit minimals| Zreazm ES‘H | Doc_TM2 | 2013/04/26

Aufwand
1 & Last Modified |

Modification User
| & Custom Attribute |
w] Actions

Leverage machine translations

The machine translation (MT) feature can automatically populate target segments whenever you open a file
or when there are no translation memory (TM) segment matches. Select a project for your MT and configure
Machine Translation options under Preferences > General Preferences .

To leverage MT:

1.

In TXLF Editor view, on the Translation tab, click Machine Translation to submit the source segment for MT
and populate the target segment with the results.

_a = [ = =
E B B B B S S g 8

MNext Previous Commit Leverage Mark All - Copy h Commit Concordance Machine Analyze
Segment Segment Transzlated Source All Search Translation

. (Optional) Verify that the quality of the translation for the source segments aligns with your requirements.

The target segments are populated with the MT for the source segments.

. (Optional) If you are updating the current segment only, continue your work and repeat as often as necessary

until you are ready to save and commit all translated segments to the TM.



/. Terminology lists

Terminology lists provide users with the ability to standardize term usage and to control the use of terms, variants
of terms, and parts of speech allowed for terms. A terminology list includes a glossary, a specialized list of source
terms, their definitions, and their preferred translations. It also includes alternate phrases for blocklisted terms.

Segment selection highlights terms from the terminology list on the Terminology pane along with potential
translation options.

There are two possible methods for moving among terms on the Terminology pane.

e Click Next Term (Ctrl + 9) or Previous Term ( Ctrl + 8).

QRG-En-FrCa_fr-CA-Training Excel-fr-CA#TR XE#txisx X N
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TM Lookup Notes Segment Histe + = Terminology
Search Glossaries (Source) ~Q X & -
# | Source Target i
: ! Available
1 In the Available Dans le do Disponible )]
folder, select a Available, : P
submission, then  |une soumi: | Folders ®
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|

L1 ..

EN — FR-CA Segments: 0/145 | Segment (Src/Tgt/Max): 93/132/- | Paragraph (Sre/Tgt/Max): 93/132/-

The term highlight identifies the type of translation match between the source term and the terminology list.

. Use Highlight All Terms to view highlights for term matches in the open file.

Color Code Category

Green Exact term match

Yellow Fuzzy term match




Color Code Category

Red Missing exact term match

Purple Missing fuzzy term match

Add a term

You can add terms to both local and remote glossaries. You need read and write user permissions to add terms to
a remote glossary that is not read-only.

To add a term to a glossary:

1. On the Terminology pane, select a word in the source segment and, optionally, the translation in the target
segment, then click +

2. (Optional) On the Add Term dialog, enter content in the Description field.

Required fields are marked with a red asterisk.

Add Term x
W Use this page to add a term to the selected glossary.
Source:* INTEGRATE WITH
Target:* INTEGRATION MIT
Description:
Glossary: Doc_Termd -
0K Cancel

3. Select the proper Glossary from the drop-down list.
4. Click OK.

The new term is added to the glossary.

Edit a term

0 You can only edit terms in the local glossary.

To edit a term:



1. Inthe TXLF Editor view, on the Terminology pane, select a term.

+ A X ¢ = Terminology
Search Glossaries (Source) ﬂ x -I:I-
project .

@

projekte

Project Management
Projektmanagement

L ]
2. Click the Edit term icon 7’ .

3. On the Edit term dialog, make your edits.

W Use this page to edit a term in the selected glossary.

Source:

| project |

Target:

| projekte |

Description:

Modify Cancel

4. Click Modify.

The term is edited.

Insert a term

To insert a term into the current target segment:
1. In the TXLF Editor view, click the location for term insertion.

2. Select the term to insert from the Terminology pane.

3. Click + on the upper left menu bar within the Terminology pane.

The term is inserted into the target segment.



Search for a term

To search for a term:
1. On the Terminology pane, enter a term in the terminology filter field.
2. Click the Search for Term icon = .

The search results from the connected glossaries are displayed.

+ = Terminology
|pruje~c:t - ‘ 40 X 'ﬂ'
project .
projekte ®
Project Management o
Projektmanagement
Project Director

; ®

Project Director

Copy aterm

To copy a term from the glossary into the current target:
1. In the TXLF Editor view, click a segment that contains glossary terms.

2. On the Terminology tab, click Previous Term or Next Term to select a source term.
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3. Click on the target location where you want to copy to the glossary term.



4. Click Copy Term.
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The glossary term is copied to the target segment.

Copy a synonym
To copy a synonym for a term:

1. Inthe TXLF Editor view, select a source term in a segment that has a glossary term.

This highlights and adds a border around the source and target terms. Synonyms display on a temporary pop-
up pane and on the Terminology pane.

Before working on a submission| file, yvou must claim

it. Source: submission

9 : Target: soumission
Avant de travailler sur [INSSEETIees yret:!

€

devez le demander.

+ = Terminology

Search Glossaries (Source v | Q) ¢ & ~

submission .
soumission ®
File

Fichier ©
Cil. . | °

2. Click within the target segment at the location where you want to copy the term.

3. Click the preferred target term from the Terminology pane. This copies the term to the cursor location in the
target segment.

An alternative is to click Copy Term. This also copies the term to the cursor location in
the target segment.




Previous Copy Mext Highlight Open
Term Term Term All Terms | Glossary

The target synonym is copied to the target segment.

Remove a term

You can only remove terms from local glossaries, not read-only or remote glossaries.

To remove a term:

1. In the TXLF Editor view, go to the Terminology pane.

2. Select a term, then click x

Use the Remove Term x at the top of the Terminology pane. Do not use the Reset

Search x This clears the filter.

A warning message notifies you of the pending deletion and asks you to agree to the term removal.

3. Click Yes.

The term is removed from the local glossary.



Tags contain information related to a block of text, such as format or indentation. Tags are not translated and
come in pairs: an opening and a closing tag.

Translations must retain the same tags at the correct location within a target segment.

Unless you have disabled Remove incomplete tag pairs in Preferences> General

Preferences >Tags , a warning message results when you try to save a target

segment with a missing tag or an open tag. An open tag is part of a tag pair in the
target segment that is missing its matching close tag. The warning will give you three
choices: Fix Manually, Delete, or Always delete. Hover over a tag to view tool-tip
information.

2] 1] B_‘TRANSLATID
oo

Tags contain numerals to indicate their order in the segment.

Red

Purple

Blue

N MANAGEMENT. @

2354255#2358235 high

hiMame="Gotham Medism" hidden

260" backgroundColors="0#D80E0"

This is a tag you currently selected, such as the first tag, II in the file.

This is a tag that specifies formatting, such as

This is a tag that specifies non-formatting controls, such as (Tag 1 JG Tag 1]

Any inline tags for the following HTML entities are displayed with a specific inline tag image to show the actual
character of the entity. This is to help linguists to view the character representation of the entities directly without

hovering over the tags.

Entity Tag Image Entity Tag Image Entity Tag Image
&amp; & &ldquo; “ &ge; >

&lt; < &lsquo; ‘ &#8804; <

&gt; > &mdash; — &HATT, *
&quot; " &nbsp; 0 &plusmn; *
&#39; ! &#160; o &acute;

&apos; ' &ndash; - &micro; J
&bull; . &raquo; » &mu; J
&copy; © &rdquo; ? &middot;

&deg; i &reg; ® gordm; 0
&frac12; : &rsquo; ’ &shy; --- (soft hyphen)
&frac14; Ya &trade; ™ &sup2; 2
&frac34; % \' ' &sup3; 3




Entity Tag Image Entity Tag Image Entity Tag Image

&hellip; \" "
&laquo; « &#8805; >

The maximum length check counts HTML entities such as: &. These are real
characters and are counted as part of the overall character count (1 Character per
entity).

Copy a tag

Translated content retains the formatting of the source content, so tags are an important element in the final
translation. You can copy tags from the source to the target for formatting and indentation accuracy.

Use Preferences > General Preferences > Tags to configure tags as full name, short
name, or numbered tags.

To copy a tag:
1. Open afile.

2. In the TXLF Editor view, on the Translation tab, select a segment with tags.

When the selected segment contains tags, the first tag is automatically selected. Red
indicates selection.

3. Choose one of the following actions:

e Click a source segment tag and drag it to the corresponding location in the target segment or press Ctrl
+Alt+Down Arrow.

e Click a source segment tag, then click in the corresponding target segment location and click Copy Tag.
e Right click a source segment tag, select Copy (Ctrl+C) in the drop-down menu, click in the corresponding

target segment location, then select Paste (Ctri+V).
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The target segment, highlighted in blue, contains the copied tag at the cursor location you selected in the
target segment.

4. (Optional) Click Previous Tag or Next Tag to select another tag and repeat the process.

Copy all tags



Use Preferences > General Preferences > Tags to configure tags as full-sized or
shortened.

To copy all tags:
1. Inthe TXLF Editor view, open a file.
2. On the Edit tab, click Copy All Tags.

All copied tags display at the location of the cursor. Reorder them to mimic the source
content order using the drag-and-drop or copy-and-paste technique.
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3. Select Segment or Document from the drop-down menu.

Segment or Alt+A Select to copy only the tags for the selected segment to the target.

Document or Alt-Shift+P Select to copy all tags for the entire document.

All tags are copied to the segment or document.

Edit a tag

Most tags in your target content have specific formatting and indentation settings copied from the source. You can
modify tags to change content format in the translated file.

Do not edit tags in the source segment.

To edit a tag:

1. Open a translation file.

2. In the TXLF Editor view, select a tag in a target segment.
3. Choose one of the following actions:

e On the Translation tab, click Edit Tag. Edit tag button
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e Right-click the tag and select Edit Tag from the drop-down menu.



4.

5.

On the Edit Tag dialog, modify the tag.

0 Verify that all tag edits are valid. Otherwise, the file could become corrupt.

[Edit Tag x
W You can edit tag content below. Note: Adding
invalid edits can corrupt the file on cleanup.
=ffontFormai=
OK Cancel
Click OK.

Edits to the tag are saved.

Clear all tags

Use Preferences > General Preferences > Tags to configure tags as full-sized or
shortened.

To clear all tags:

1.
2.

Open a file.

In the TXLF Editor view, on the Edit tab, click Clear All Tags.
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. Select Segment or Document.

Segment or Ctrl-Shift+V | Select to clear only the tags from the selected segment.

Document | Select to clear all segment tags for all target segments in the file.

A warning message asks you to agree to clear all tags from the open file.

. Click Yes.

All tags are cleared for the target segment or for all target segments in the document.



Delete a tag

You may choose to delete target tags, particularly if there are multiple copies of the same tag in the same target

segment. You can only delete target segment tags.

To delete a tag:

1. Open a translation file.

2. In the TXLF Editor view, select a tag in a target segment.

3. Choose one of the following actions:
o Press Delete or Backspace.
e On the Edit tab, click Cut, then paste the tag elsewhere.
ﬂ Edit Ry e
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Undao Redo Cut Copy Paste Find / Copy All - Clear All
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o To undo the change, click Undo or press Ctrl + Z.

The target tag is deleted.



9. Manage project notes

You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.

There are two ways to access the Notes editor.

e Use the Notes tab on the Editor pane to view and manage project notes.
¢ Use the Notes icons on the Review tab to view and manage project notes.

View notes

The Notes tab is on the Editor pane. Notes retain the same ID as the related segment.

G Segments with notes include the Notes icon O in the Status column.

To view notes:
1. Open a translation file.

2. In the TXLF Editor view, click the Notes tab on the Editor Pane, then view note details for all file segments.

TM Lookup Notes Segment History Metadata Transcheck (0)

Add Note Edit Note Delete Note

ID | Type Date Details
Translation |2018/08/27 Use Vereinfacht as the approved
16:30:54 MDT | phrase for this project.

EN-US — DE-DE  Segments: 733 | Segment (Src/TgtMax): 1212/ | Paragraph (Src/Tgt/Ma;

Notes for all file segments are displayed.

Add a note

To add a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment.



3. Choose one of the following actions:
o Click the Notes tab on the Editor pane, then click Add Note. Editor pane Notes tab showing Add
Note button

TH Lookup Motes Segment History Metadata Transcheck (0} .
Add Note Edit Note Delete Mote Export Notes
I | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. M
13:19:02 MDT

Submitter Question 2018/06/04 Are you treating "internal translator”

139 13:19:21 MDT as a single phrase for DE?
L 3
EN — DE-DE Segments: 2933 | Segment (Src/TgtMax): 83/83/~  Par

e On the Review tab, click Add Note, or right click on the target segment and select Add Note to open Add/
Edit Notes dialog.
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4. On the Add/Edit Notes dialog, select a Type from the drop-down list.

W Use this page to add or adit a note.

Segment ID: 13

Source: Allow access fo any vendor or internal franslator
for maximum resource flexibility

Creator” Submitter
Date: 2018/06/04 13:10:38 MOT

Type: Transiation] -

Review

Question
Important

Tranglation

OK Cancel

0 The selected note Type is saved for the next time Wordfast is run.

Type Description

Translation Select to include data for the reviewer from the translator.

Review Select to includes data for the translator from the reviewer.
Question Select to solicit a response about the segment from a user.
Important Select to flag the data for the segment as a priority for other users.

5. Enter the information in the note field.
6. Click OK.

The note is saved and associated with the segment.

Edit a note

To edit a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment with a note.



3. Choose one of the following actions:
o Click the Notes tab on the Editor pane, then click Edit Note. Editor pane Note tab showing edit note

button
TH Lookup Motes Segment History Metadata Transcheck (0} .
Add Note Edit Note Delete Mote Export Notes
I | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. M
13:19:02 MDT

Submitter Question 2018/06/04 Are you treating "internal translator”

139 13:19:21 MDT as a single phrase for DE?
L 3
EN — DE-DE Segments: 2933 | Segment (Src/TgtMax): 83/83/~  Par

e On the Review tab, click Edit Note. Edit note button

File Edit Formatting Translation Terminology

B e B B B B

Spellcheck File Mark Spelling Add Nots Edit Mote Delete Mote Export Notes
Errors




4. On the Add/Edit Notes dialog, edit the note.

Add/Edit Notes x

W Use this pagse to add or edit a nots.
Segment ID: 113 |
Sourca: Allow access to any vendor or internal franslator
for maximum resource flexibility.

Creator:™ | Subrnitter |
Date: | 2018/06/04 13:19:02 MDT |
Type: |R&uim\r - |
Check for correctness.

0K Cancel

5. Click OK.

The modified note is saved and associated with the segment.

Delete a note

To delete a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment with a note.



3. Choose one of the following actions:

e Click the Notes tab on the Editor pane, then click Delete Note. Editor pane Note tab selected
showing delete note button

TW Lookup Motes Segment History Metadata Transcheck (0) -
Add MNote Edit Mote Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter Review |2018/06/04 Check for correctness. )
13:19:02 MDT

Submitter Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

L 3
EN — DE-DE Segments: 2933 | Segment (Src/TgtMax): 83/83/~  Par

e On the Review tab, click Delete Note.
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The note is no longer attached to the segment. If there are no other notes, the notes icon is removed from the
Status column for the segment.

Export notes

To export notes:

1. Open a translation file.



2. In TXLF Editor, choose one of the following actions:
e Click the Notes tab on the Editor pane, then click Export Note. Editor pane Notes tab showing
Export notes button

TW Lookup Motes Segment History Metadata Transcheck (0) -
Add MNote Edit Mote Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter Review |2018/06/04 Check for correctness. )
13:19:02 MDT

Submitter Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

1 k

EN — DE-DE Segments: 2933 | Segment (Src/TgtMax): 83/83/~  Par

e On the Review tab, click Export Notes. Export Notes button
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e Right-click the segment and click Export Notes.
3. On the Export Notes dialog, browse and select a location for the exported notes file.
4. Enter a file name and click Save.

All notes for the open file are saved in the selected folder location as a table in either MS Word or HTML file
format.



10. Transcheck

You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments.

“ is displayed in the Status column for segments with errors.

To enable Transcheck and customize Transcheck options, configure in Preferences >
Current Project Preferences > Transcheck .

Use transcheck

After you have configured Transcheck options, you can begin using Transcheck when you translate or review a
segment and commit it to the TM. You can also use the Transcheck configuration option Transcheck segments
while translating to check for errors during the translation process.

To use Transcheck during translation:
1. In the TXLF Editor view, select a segment and complete your translation of that segment.

2. Select Next Segment or press Alt+Down Arrow to update the TM, move down one segment, and leverage
the next segment from the TM.

3. (Optional) If Transcheck identifies an error in the segment, it posts a warning message. Choose one of the
following actions:
e Select Go back to fix issue to correct the error.

e Select Continue to continue translating without changes.

If you choose to correct the error, the Error Status icon o is removed from the Status column and from the
Transcheck tab.

If you do not correct the error, the Error Status icon “ remains in the Status column and on the Transcheck
tab.

Use Transcheck All

Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issue
warnings for missing and incorrect text. Configure and enable your Transcheck preferences under Preferences >
Current Project Preferences > Transcheck.

Do not use Transcheck All if you want Source and Target Consistency checks. Instead, use Transcheck Report
from the Project Files tab on the Current Project view.

. Use the Transcheck All option before you complete a file.




To use Transcheck All:
1. In the TXLF Editor view, finish translation of all segments in a file.

2. Click the Review tab, then click Transcheck All.
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In General Preferences under Warnings, if Transcheck All Warnings is selected a Transcheck All
Warning pop-up dialog appears. The "Do not warn me about this anymore" checkbox will turn off this pop-up
dialog. The Use Transcheck Report From Current Project view link will open the Project Transcheck dialog.

3. Click Continue.

Transcheck All Warning x

Source and Target Consistency check will not be reporied using Transcheck All
' aption from TXLF Editor pane.

Use Transcheck Repori From Current Project view fo get report for Source and
Target Consistency Check.

Do not warn me about this anymare

A Transcheck report and summary results.



4. (Optional) On the Transcheck Report, determine the terminology errors you want Transcheck to ignore from
highlighted terms in the Terminology Check report section.

To best optimize the Transcheck Report, you can configure Transcheck to ignore
highlighted terms you identify under conditions you specify. The terms and conditions
you select are in the Ignored Terminology Errors section of the report.

Il

Report is optimized for Google Chrome, some features might not work well in your current browser.

Project TransCheck Report
Report Summary (1 files)

File Mame Errors in file {visible highlights)

PD_en-de.docx. txdf ]

Ignored Terminology Errors:

|I mor |I Action " Condition Ill':.':u'r.-'v' I

Highlight: ] Exact Mateh B Fuzzy Mateh| ] Exaet (No Mateh) [|Fuzzy (No Mateh)

| Toggle Global Search Filters | Global search filter is OFF

Project TransCheck Report - Wordfastl - English - German
Report Summary (1 file)

TransCheck ran succassfully on 1 file and found 39 errors.

Target Consistency Check ran successfully with 0 errors.

Source Consistency Check ran successfully with 0 errors.

File Mame Total Number of Errors
PD_an-da.docx. txIf e

PD_en-de.docx. txif

Empty Target Check

=

Edited Source Check 0
Capitalization Check 0
Elunedited Fuzzy Check 11
Mledited Exact Check 3
Espeling Check 16
EITag Check 5
Elwhitespace Check 4
Repeated Words Check 0

Unedited Fuzzy Check

Block Source Target Score Comment

5] 1-6-1 | ACCESS REAL-TIME DATA ZUGRIFF AUF 75% Target contains a

5. (Optional) Click a highlighted term.



6. (Optional) On the Ignore Terminology Transcheck Error dialog, compare the source string with the target
equivalents.

7. (Optional) Select either When term is for source terms in the glossary or When target contains for target
terms.

Ignore Terminology Transcheck Error X

Source string: Sirea "
{ ¥
¢ Whemtemi o Sieamine(eine Stiomirienfor l
[StraamlinafOntimierunn) &
Py >
When Target
O Contains:
Ignore Ignore All (3) Mext

8. (Optional) Either click Ignore to disregard the single instance of a string or Ignore All to disregard every
instance of a string.

0 The number following Ignore All contains the total number of instances within that file.

Ignore Terminology Transcheck Error

Source string:

] When term is:

When Target Ubersetzungsprozess
® Contains:

Ignore All (3) Previous Next




9. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.

transcheckReport5481583249647184112 html 16

Ignored Terminology Errors

Error I Action I Condition II Instances

translation process was translation process 1
ignored  (Ubersetzungsprozess)
when
term is:

enterprise was ENTERPRISE 3
ignored (BERICHTERSTELLUNG)
when
term is

VENDOR was VENDOR(ANBIETER) 1

ignored
when

term is:

Highlight: &1|Exact Match| [-1|Fuzzy Match| [F1|Exact (No Match)| [-]|Fuzzy(No Match)

Terminology Check:
transcheckReport5481583249647184112.html

' Hide this report |

Seq.| Block Source Comment

1D 1D
3 1-3-1 STREAMLINE @ EFFEKTIVES Incorrect terminology:
PROJECT PROJEKTMANAGEMENT  streamline (eine
MANAGEMENT Stromlinienform geben),
STREAMLINE

fANTTMTED ERY

10. (Optional) After closing the Transcheck report, select any remaining segments with the Error Status icon “
in the Status column.



11. (Optional) Click the Transcheck tab to examine the details of the segment error.

The total number of errors in the segment is the number in parentheses on the
Transcheck tab.

TM Lookup Notes Segment History Metadata Transcheck (3)

Previous error Next error Refresh lgmore war
# Warning Explanation Cause
1 | Tag Check Source contains Source contains "1, 2,
formatting missing in 3" which is missing in
the target. target.
2 | Unedited Fuzzy Target contains a Target contains a 98%
Check fuzzy match that has match that has not
not been modified. been modified.
3 | Untranslated Text | Source text is not -
_ in" should be
Check translated in the .
translated in target.
target.

12. (Optional) Click Next error or Previous error on the Transcheck tab to view the next or prior segment error.

13. Choose one of the following actions:

e Correct the error and click Refresh to complete the correction.

e Click Ignore warning to continue reviewing error warnings without making any changes.
If you correct the error, the Error Status icon ﬂ is removed from the Status column.

If you do not correct the error, the Error Status icon “ remains in the Status column.



11. Leverage project TMs

A translation memory (TM) provides maximum content re-use and facilitates collaboration among localization
resources. Users can leverage reusable content using one of two different types of TMs.

Consider using a hosted service: WordFast Anywhere (WFA). WFA allows translators
= to connect to a shared server and interact with a private, remote TM and glossary.

Local TM Located on your local computer system and only you can access it.

Remote TM Located on a server that other translators can access. This allows multiple
translators to leverage the available content and update the TM with new reusable
content.

You can remove a TM from a project so it is no longer in the project TM list. When
you remove a local TM from a project, it remains in the TM folder on your computer
system. To add a removed local TM back to the project, use the Add Local action on
the Project TM tab. To add a removed remote TM to the project, use the Connect to
Remote action on the Project TM tab.

Create a local TM

Create a local translation memory (TM) for quick, local access. If it is possible you may need to share your TM
with other users, connect to a hosted service: Wordfast Anywhere (WFA). Refer to Connect to a remote glossary
on page 121.

To create a local TM:
1. In the Project List view, on the Projects tab, select a project from the projects list to open it.
2. On the Project TM tab, select Create Local.

Project Files Project TM Project Terminology Reporis Reference Files

= | .o = W . = = -
Create Add Add Connect Open Modify Copy Import Export Remove

Local Local Project Ths To Remote ™ ™ ™ ™ ™ TM




3. On the Translation Memory dialog, enter the required TM configuration.

0 Required fields are marked with a red asterisk.

Translation Memory x

W Create Translation Memory

Name:™* |

Target Language:* German -
Loc ation:* Browse...
Priority:* Secondary -
| Selected

Read-only

OK Cancel

Field Action

Name Enter a unique TM name that includes the client or organization name and the
TM's language for easy identification.

Target Language Select target languages. Target languages are limited to those languages
configured in the project.

Location Select the destination where the application saves the new TM.

Priority Set the TM sequence used during translation, using the Primary TM first,
followed by any Secondary TMs.
You can only select one TM as primary.

Selected (Optional) Select to use the current TM for the project.
Read-Only (Optional) Select to leverage the TM without updating it with the new translation.
4. Select OK.

The new TM is created and is displayed in the Project TM list.

Add a local TM to a project

You can add a local TM to your project at the time of creation or as a separate action.

You can add TMs created by Wordfast Pro 4 or 5 only. If you want to add TMs from
Wordfast Classic or Wordfast Pro 3, use the Import TM option.



To add a local TM to a project:
1. On the Projects tab, double-click a project from the projects list.
2. Select the Project TM tab, then select Add Local.

Project Files Project TM Project Terminology Reporis Reference Files

= S0 W S@ S = = 0
Create Add Add Connect Open Modify Copy Import Export Remove
Local Local Project TMs To Remote ™ TM ™ ™ ™ TM

3. On the Opening TM dialog, browse to the local TM folder and select it.
4. Select Select Folder.

The selected TM is added to the project and displayed in the Project TM list.

Add project TMs

Some projects may use multiple local and remote translation memories (TMs). In such instances, it is more
efficient to add all of the TMs for the project with a single Add Project TMs action.

To add project TMs:
1. In Project List view, on the Projects tab, double-click a project from the projects list.
2. Onthe Project TM tab, select Add Project TMs.

Project Files Project TM Project Terminology Reporis Reference Files

S o S w B = S & 0
Create Add Add Connect Open Modify Copy Import Export Remove

Lecal Local Project ThMs To Remote M M ™ ™ ™ ™



3. On the Add Project TMs dialog, enter the project TM information.

W Select a Project containing TMs you would like to
add

Select a Project:* AdaptiveTranscheck1 b
Source Language: | English

Target Language(s): German (Gemany)

List of ThMs: German_DE, Adaptive Transcheck-German
oK Cancel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language.
Target Language(s) Leave the auto-populated target languages.
List of TMs Review the list of TMs associated with that project.
4. Select OK.

The selected project TMs are added to the project and are displayed in the Project TM list.

Connect to a remote TM

You can connect to one or more translation memories (TMs) on other computers, including a hosted service, such
as Wordfast Anywhere (WFA).

WEFA allows translators to connect to a shared server and interact with a private,
remote TM and glossary.

To connect to a remote TM:
1. On the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, and on the Project TM tab, click Connect To Remote.

Project Files Project TM Project Terminology Reports Reference Files

= .o = W N@ S 2 TR
Create Add Add Connect Open Modify Copy Import Export Remave

Local Local Project TMs To Remoie TM ™ ™ ™ ™ ™




3. Onthe Connect to Remote TM dialog, select the appropriate tab, based on your server options.

e TM Server
o WF Server
o WFA Server

4. (Optional) Add a TM Server on the TM Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

W Use this page to connect to remote TM.

TM Server WF Server WFA Server

Symbolic Mame:”

URL Ssttingz

URL:" example: tm:/

Address:”

Part:

TMS Folder:”
Cluster Short Code:”
TM Short Code:"
User”

Password:"

Workgroug 10:

TM Updats Sattings

TM Cleanup Passcode:

Priarity: Primary
W Selected

Read-only

Field or Option

jladdress:port TMS#tm=LE( Test

OK Cancel

Action

Symbolic Name

Enter a unique name for the TM. The symbolic name can be automatically
populated from the URL String for remote TM connections.

URL

Enter the remote TM URL using the following format: t ns: / / addr ess: port/
TMS?. The remaining URL Settings automatically populate when you enter the
URL string. Click Test to validate the connection. The symbolic name can also be
automatically populated from the URL String for remote TM connections.

TM Cleanup Passcode

Enter the password to update the TM for the project.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.




Field or Option

Action

Read-only

(Optional) Select to leverage the TM without updating it with the new translation.

5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, then click OK.

Required fields are marked

with a red asterisk.

W Use this pagse to connect to remote TM.

TM Server WF Server WFA Server
Symbolic Name:” Sample_TM
URL Ssttings
URL:* example: wf
Address™”
Port:”
Account Name:”
Account Passwaord:
Workgroup 1D:
Ph and TM admin
Use TM (Write) Passwaord
Priority: Primary
| Selected
Read-only

Field or Option

Hsmith: password@address Test

0K Cancel

Action

Symbolic Name

Enter a unique name for the TM. The symbolic name can be automatically
populated from the URL String for remote TM connections.

URL

Enter the remote TM URL using the following format: wf : / /

j smth. passwor d@ddr ess: port/ TM5?. The remaining URL Settings
automatically populate when you enter the URL string. The symbolic name can
also be automatically populated from the URL String for remote TM connections.
(Optional) The Password and Workgroup ID fields depend on server settings.
Click Test to validate the connection.

Address

Enter the address associated with the URL.

Port

Enter the port associated with the URL.

Account Name

Enter the username associated with the URL sign in.

Account Password

(Optional) Enter the password associated with the username.

Workgroup ID

(Optional) Enter the workgroup ID for the project.




Field or Option

Action

Use TM (Write)
Password

Enable, if you are a PM or TM Administrator, to require a password to overwrite
the existing TM with new translations.

TM (Write) Password

If enabled, enter the password to overwrite the existing TM with new translations.

Selected

(Optional) Select to use the current TM for the project.

Read-only

(Optional) Select to leverage the TM without updating it with the new translation.

6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

W Use this page to connect to remote TM.

TM Server WF Server

Symibolic Name:*
AP key:”
Priority:

Selecied

Read-only

Field or Option

WordFast Anywhere Adaptive Test

Test

OK Cancel

Action

Symbolic Name

Enter a unique name for the TM.

API key Enter the API key you obtain from WFA.
a. Signin to your WFA account at ht t ps: / / ww. wor df ast . coni
nmyaccount .
b. Click TMs & Glossaries, then Setup.
c. Onthe TMs and glossaries management dialog, select a TM or glossary.
d. Click Manage Sharing.
e. Onthe TMs and glossaries shares dialog, click the API key and copy the
text string.
f. Paste the API key into the Connect to Remote TM dialog using the following
format: user nanme@ 234567, then click Test to validate the connection.
Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.
Selected (Optional) Select to use the current TM for the project.
Read-only (Optional) Select to leverage the TM without updating it with the new translation.

The new TM is added to the project and is displayed in the project TM list.


https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount

Open and edit a local TM

You can open and edit local translation memory (TM) entries at any time after TM creation.

To open and edit a local TM:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

c You cannot open a remote TM in TM Editor.

2. Onthe Project TM tab, select a translation memory and select Open TM.
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4. (Optional) To search for source or target translation units (TUs), enter your search criteria in the appropriate
fields in the Filters sidebar, then select Find.

You can make your filtered search case-sensitive or specify an exact match, then filter
further by creator, user, and modification date.

5. (Optional) To reset your search criteria, select Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit a TM entry.

Modify a TM

To rename, write-protect, or change the priority of a TM, use the Modify TM action.

To modify a local or remote TM:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. On the Project TM tab, click a TM.

3. Click Modify TM.
Project Files Project TM Project Terminology Reporis Reference Files
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4. On the Connect to Remote TM dialog, modify the details for your connection. Based on your selection, other
fields auto-populate. Refer to Connect to a remote TM on page 109.

0 You can only select one primary TM for a project.

Required fields are marked with a red asterisk.

Connect to Remote TM x

W Use this page to connect to remote TM.

TM Server
Symbolic Nama:* Sample_TMS_DE-de
URL Settings
URL:* tms.// g = s cOM/TMS? Test
Address:" ° ey com
Port:
TMS Folder:* ™S
Cluster Short Code:* GROO000003
TM Short Code:” LTMOO000S
User:” LTM-en-de
Password:" & w
Workgroup 10:

TM Update Settings

TM Cleanup Passcode:

Priority: Primary v
W Selected
Read-only
oK Cancel

5. (Optional) Select the TM identified in the Name field for the current project using Selected.
6. (Optional) Select Read-only to allow users to leverage the TM but not update it with new translation.
7. Click OK.

Your modifications to the TM are saved.

Copy a local TM

Copy a TM to use an existing TM for a new project.



0 The copied TM is in the Wordfast Pro TM format, regardless of the original TM format.

To copy a local translation memory:
1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. On the Project TM tab, select a translation memory and select Copy TM.

Project Files Project TM Project Terminology Reports Reference Files
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3. On the Copy Translation Memory dialog, enter the TM Name.

0 Required fields are marked with a red asterisk.

ap Create acopy of the selected franslation memory. Please enter a name for
the copy, location, and decide if you want to flip the TM languages.

Source TM: Doc_TM1

Mame:* |

Location:* Browse...
Flip Languages

Copy Cancel

4. Browse and select the Location on your disk for the TM copy.
5. (Optional) Select Flip Languages, to reverse the source and target languages, then select Copy.

A copy of the translation memory is saved in the selected folder location.

Import a local TM

To use a local translation memory (TM) from another linguist, use the Import TM action.
To import a local TM:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Select Import TM on the Project TM tab.
(S8 B Froject Terminology  Reports  Reference Files
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3. On the Import Translation Memory dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.
W Import Translation Memory

File Type:" TMX -

Import File:™ C\Users\Deskiop\de-DE TM\TranscheckDE tmx Browse...
Create Mew TM

#) Import Into Existing TM

Existing Th:" -

If TU already exisis” Add as a new TU -

Delete all TUs from existing T

0K Cancel

Field Action

File Type Select an action from the drop-down list.
e TMX — Translation Memory eXchange file format provides compatibility
with all translation tools.

e WF TXT TM format (.txt) — File format provides backward compatibility
for Wordfast Classic and Wordfast Pro 3.

Import File Browse to select the file for import.

Create New TM Select to import the TM into a new TM file.

Import into Existing TM Select to import the TM into an available TM file, based on selection from the
drop-down list.

Existing TM Select an available TM file from the drop-down list.
If TU already exists Select a TM option from the drop-down list to import it into an available TM file.
Delete all TUs from Select to delete the existing TM and replace it with the new TM.
existing TM
4. Select OK.

The translation memory is imported and is displayed in the Project TM list.

Export a local TM

To share a local translation memory (TM) with another linguist, use the Export TM action.

To export a local TM:



=

. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Select a TM assigned to that project.
3. Select Export TM on the Project TM tab.
[WSWE ' Froject Terminology ~ Reports  Reference Files
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Create Aad Agd Connect Open Modify Copy Import Export Remove:
Local  Local Project TMs  ToRemote  TM ™ ™ ™ ™ ™
4. On the Export Translation Memory dialog, choose a location and export type for the TM export file.
° Required fields are marked with a red asterisk.
Export Translation Memory x
- Specify existing Translation Memory for export, and
choose a location and export type for the TM
Translation EN_DE-de -
Memory:®
Export Type:" ThX b
File: Location:* Browse...
OK Cancel
Translation Memory Select a TM from the drop-down list.
Export Type Select the export file type from the drop-down list.
File Location Browse and select the folder location for the export.
5. Select OK.

The selected translation memory exports to the selected folder location.



12. Leverage project terminology lists

Terminology is a phrase used to identify two distinct groupings: the glossary and the blocklist.

¢ Glossary—A database of preferred source terms, words, and phrases paired with their target equivalents
designated as preferred and client-specific
¢ Blocklist—A database of rejected target terms prohibited from use in the translation

You can use the Project Terminology tab to modify and remove glossaries and blocklists.

Create a local glossary

To create a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, click Create Local.

Project Terminology Reports Reference Files
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Create Add Connect Open Import Export Add Project
Local Local To Remote Glossary Glossary Glossary Gloszaries

3. On the Create Glossary dialog, enter the glossary information.

Create Glossary x

W Create/Modify Glossary

Name:* |

Target Language:* German -
Location:* Browse...
| Selected

Read-only

oK Cancel

a Required fields are marked with a red asterisk.

Field Action

Name Enter a unique name for the glossary.

Source Language Do nothing, since the source language auto-populates.

Target Language Select a language from the target languages available for your project in drop-

down list.




Field Action

Location Browse and select the folder location for the new glossary.

Selected (Optional) Select to use the current local glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating it with new terms.
4. Click OK.

The new glossary is displayed in the project glossary.

Add a local glossary

You can only add glossaries created by Wordfast Pro 4 or 5. For glossaries from Wordfast Classic or Wordfast
Pro 3, use the Import Glossary action. Refer to Import a local glossary on page 126.

To add a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.
2. In the Current Project view, on the Project Terminology tab, select Add Local.
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3. On the Creating Glossary dialog, browse to a glossary folder and select it.
4. Select Select Folder.

The selected glossary is added to the project and is displayed in the project Glossaries list.

Add project glossaries

Some projects may use multiple local and remote glossaries. In such instances, you can add all of the glossaries
from a previous project with a single Add Project Glossaries action.

To add project glossaries:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select Add Project Glossaries.
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3. On the Add Project Glossaries dialog, enter the project glossaries information.

- Select a Project containing Glossaries you would
like to add

Select a Project:” AdaptiveTranscheck1 o
Source Language: |English

Target Language(s): German (Gemany)

List of Glossaries: de-DE-TechDoc

OK Caneel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language, based on the project.
Target Language(s) Leave the auto-populated target languages, based on the project.
List of Glossaries Review the list of glossaries associated with that project.

4. Select OK.

The selected project glossaries are added to the project and displayed in the project Glossaries list.

Connect to a remote glossary

You can connect to a glossary residing on another server, including a hosted service, such as Wordfast Anywhere
(WFA).

WEFA allows translators to connect to a shared server and interact with a private,
remote translation memory (TM) and glossary.

To connect to a remote glossary:
1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Connect To Remote.

M0 b B Om o @
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3. On the Connect to Remote Glossary dialog, select the appropriate tab, based on your server options.

e TMGR Server
e WF Server
o WFA Server

4. (Optional) Add a Term Manager (TMGR) Server on the TMGR Server tab and complete the required fields.

a Required fields are marked with a red asterisk.

TMGR Berver WF Server WFA Server

Mame:*

Target Language:~ German (Germany) -
URL Settings
URL:" example: tmgr.faddress:porbimgr? Test
Address"
Username:”
Password:"

Project Short

example: ABCO000001, ABCOO000002
Code:"

W] Selected
Read-only

| Create Blocklist Connection

oK Cancel

Field or Option Action

Name Enter a unique name for the glossary. The name can be automatically populated
from the URL String for remote glossary connections.

Target Language Select a language from the drop-down list. This list is constrained by the available
target languages for your project.

URL Enter the remote glossary URL using the following format: t ngrs: //
addr ess: port/ TMGER?.
The remaining URL Settings automatically populate when you enter the URL
string. This includes the username, password, and project short code. The name



Field or Option

Action

can also be automatically populated from the URL String for remote glossary
connections.
Click Test to validate the connection.

Selected

(Optional) Select to use the current glossary for the project.

Read-only

(Optional) Select to leverage the glossary without updating new terms.

Create Blocklist
Connection

(Optional) Select to connect to an available blocklist already in TMGR.

5. (Optional) Add a WF Server on the WF Server tab and complete the required fields.

Required fields are marked with a red asterisk.

W Connect To Remote Glossary

TMGR Server WFA Server

MName:* Sample_Glossary

URL Sstiinga

URL:" example: wiijsmith:passwon

Address”
Port:”
Account Name

Account Password:

Field or Option

d@ad Test

0K Cancel

Action

Name Enter a unique name for the glossary. The name can be automatically populated
from the URL String for remote glossary connections.

URL Enter the remote glossary URL using the following format: wf : / /
j smith: passwor d@ddress: port/tngr?. The remaining URL Settings
automatically populate when you enter the URL string. Click Test to validate the
connection. The name can be automatically populated from the URL String for
remote glossary connections.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Account Name

Enter the username associated with the URL sign in.

Account Password

(Optional) Enter the password associated with the username.

Workgroup ID

(Optional) Enter the workgroup ID for the project.

Selected

(Optional) Select to use the current glossary for the project.




Field or Option Action

Read-only (Optional) Select to leverage the glossary without updating new terms.

6. (Optional) Add a WFA Server on the WFA Server tab and complete the required fields.

W Connect To Remote Glossary

TMGR Server WF Server

Name: WordFast Anywhere Adaptive Test

Target Language: German (Germany)
APl KEY username(@ 1234567 Test
Selects
Read-only
0K Cancel
Field or Option Action
Name Enter a unique name for the glossary.
Target Language Select a language from the drop-down list.
This list is constrained by the available target languages for your project.
API KEY Enter the API key you obtain from WFA.
a. Sign in to your WFA account at ht t ps: // www. wor df ast . cont
myaccount .
b. Click on TMs & Glossaries, then Setup.
c. Onthe TMs and glossaries management dialog, select a glossary.
d. Click Manage Sharing.
e. On the TMs and glossaries shares dialog, click on the API key and copy the
text string.
f. Paste the API key into the Connect to Remote Glossary dialog on the WFA
Server tab using the following format: user nane@. 234567, then click Test to
validate the connection.
Selected (Optional) Select to use the current glossary for the project.
Read-only (Optional) Select to leverage the glossary without updating new terms.
7. Click OK.

The selected glossary is added to the project and is displayed in the project Glossaries list.

You can open and view remote glossary entries at any time after a glossary is connected.


https://www.wordfast.com/myaccount
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0 You can only view the terms in a remote glossary. You cannot edit the glossary.

To open a remote glossary from the TXLF Editor view:

1. Inthe TXLF Editor view, click Open Glossary on the Terminology tab, or click the Open Glossary icon =
on the Terminology pane.

The remote glossary will open in your default browser.

2. (Optional) If you are connected to multiple remote glossaries, clicking Open Glossary or the Terminology List
button (from the Terminology tab) opens the Project Glossaries dialog; do one of the following:

e Click a remote glossary location link.

e Select a remote glossary, then click Open.

Project Glossaries x
Name Type Location Read-o... | Active
3MCO00732_en-US_de-DE http tmgrs://stg-tmgrl.translations.comTM... L4 v
Manage Project Glossaries Open Close

3. (Optional) In the Current Project view, on the Project Terminology tab, do one of the following:

e Click a remote glossary location link.
e Select a remote glossary, then click Open Glossary.

The remote glossary will open in your default browser.

Open and edit a local glossary

You can open and edit local glossary entries at any time after glossary creation.
To open and edit a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select a local glossary, and select Open
Glossary.

Project Terminology Reports Reference Files
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3. Inthe Glossary Editor, view the terms for both source and target languages. You can also filter, add, remove,
and update terms.

Glossary Editor e A~ X
oo % b & & B §
Mext Previous Cut Copy Paste Add Term Remaove Impart Expart
Update Update Term Glossary  Glossary
_ ID | Source Target Description | Creation ... Creation... Modifica... Meodificati... 1 =
. TermEntrylD | en en:Status | ds 2019/0 ds 2019/08/ -
Source and target - 1 3;221 5 32_31 99
- 2 MDT MDT
Entfer Term Text
845312a1- Access Approved | ds 2019/0 ds 2019/08/
2 7719-4d4b- Protection 8/26 26
930a- 09:31:2 09:31:22
96f3163f07af 2 MDT MDT
4eidBled- Application | Approved | ds 2019/0 ds 2019/08/
3 Ocfb-4fal- Support 8/26 26
a818- 09:31:2 09:31:22
6f994b2b2155 2 MDT MDT
GBadc311- technology | Approved |ds 2019/0 ds 2019/08/
ef95-49f4- 8/26 26
4 |9e3e- 09:31:2 09:31:22
1eadb433dbb 2 MDT MDT
2
abfT290a- Worms Approved ds 2019/0 ds 2019/08/
89bb-446d- 8/26 26
3 |ab44- 09:31:2 09:31:22
8702c33910e 2 MDT MDT
D And ¥ Clear 2 =

4. (Optional) To search for source or target terms, enter your search criteria in the appropriate fields in the Filters
sidebar, then select Find.

You can make your filtered search case-sensitive or specify an exact match, then filter
further by creator, user, and modification date.

5. (Optional) To reset your search criteria, select Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste within the source and target columns.

Import a local glossary

To exchange glossaries with other translators, save the exported glossary to a local drive, then use the Import
Glossary action to import it to your project.



To exchange glossaries among projects on your local drive, use the Add Project
Glossaries action.

To import a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select Import Glossary.

Project Files Project TM Project Terminology Reports Reference Files
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3. On the Import Glossary dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Glossary b 4
W Import Glossary

File Type:" wkd -

Import File:™ CAUsers\Documentsi\Sourcede-DE Term\de-DE_TechDo Browse...

Create a new glossary

#) |mpart into existing glossary

Existing Glossary:” de-DE-TechDoc bl

If the term already exiziz:™ |Add as new term bl

Delete all terms from existing glossarny

oK Cancel

Field Action

File Type Select a file format for importing raw text files.

¢ Term Base eXchange (TBX) — Use with other CAT tool glossaries
¢ Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast
Pro glossaries

Import File Select Browse to locate and select an Import File.




Field

Action

Create a new glossary

Select to use the imported glossary to create a new glossary rather than add
terms to an existing glossary.

Import into existing
glossary

Select to use the imported glossary to add to the selected glossary.

Existing Glossary

Select from the drop-down list to append the imported glossary to an existing
glossary file.

If term already exists

Select from the drop-down list to import the term into an existing glossary file.

e Add as a new term — Add the term to the existing glossary file.

¢ Do not overwrite — Ignore the term and retain the term already in the
glossary file.

e Overwrite existing term — Use the new term to replace the term already
in the glossary file.

Delete all terms from
existing glossary

Select to delete the existing term and replace it with the new glossary term.

4. Select OK.

The glossary is imported and is displayed in the project Glossaries list.

Export a local glossary

To exchange glossaries with other translators, use the Export Glossary action and save it to a local drive, then
send it to another translator to import to their project.

To exchange glossaries among projects on your local drive, use the Add Project
Glossaries action.

To export a local glossary:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a glossary and select Export Glossary.
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3. On the Export Glossary dialog, select a glossary from the drop-down list.

W Export Glossary

Glossary * Doc_Term1 -

Export Type:* TBX -

File:* Browse...
oK Cancel

4. Select the file Export Type from the drop-down list.

¢ Term Base eXchange (TBX) — Use with other computer-assisted translation (CAT) tool glossaries
¢ Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast Pro 3 glossaries

5. Select Browse to locate and select the export file location, then select Save.
6. Select OK.

The glossary is exported to the specified file location.

Create a local blocklist

You can create a blocklist for your project on your local computer.
To create a local blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select Create Local in the Blocklist group.
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3. On the Create Blocklist dialog, enter the required blocklist information.

0 Required fields are marked with a red asterisk.

@@ Create a New Blocklist

Mame:*
Language:* German -
Lo ation:* Browse...
" Selected
Read-only
OK Cancel
Field Action
Name Enter a unique blocklist name that includes the client or organization name and the
blocklist target language for easy identification.
Select the blocklist's target language, which is limited to languages configured in
Language .
the project.
Location Select the destination for the new blocklist.
Selected (Optional) Select to use the current blocklist for the project.
Read-Only (Optional) Select to leverage the blocklist without updating it with the new
translation.
4. Select OK.

The new blocklist is created and is displayed in the project terminology list.

Add a local blocklist

Use a local blocklist already created on your computer when you want to leverage a translation blocklist, but do
not want to collaborate with other users. You can add a local blocklist to your project at the time of creation or as a
separate action.

To add a local blocklist:



. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

. In the Current Project view, on the Project Terminology tab, select Add Local in the Blocklist group.
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. On the Creating Blocklist dialog, browse to a blocklist file and select it.

. Select Select Folder.

The selected blocklist is added to the project and is displayed in the project terminology list.

Connect to a remote blocklist

You can connect to one or more blocklists on another computer or server.

To connect to a remote blocklist:

. In the Project List view, on the Projects tab, double-click a project from the projects list.

. In the Current Project view, on the Project Terminology tab, click Connect To Remote.
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3. On the Connect to Remote Blocklist dialog, enter the required information, based on your server options.

Required fields are marked with a red asterisk.

W Connect to Remote Blocklist

Name:* |

Target Language:* German -
URL Settings

URL:* Test
Address:*

Username:*

Password:*

Project Short Code:*

] Selected
oK Cancel

Field or Option Action

Name Enter a uniqgue name for the blocklist.

Target Language Select a target language from the drop-down list.

URL Enter the remote TMGR URL using the following format: t ngrs: //
addr ess: port/ TM5?. The remaining URL Settings automatically populate
when you enter the URL string. Click Test to validate the connection.

Address Enter the remote address.

Username Enter the username associated with the URL sign in.

Password Enter the password associated with the username.

Project Short Code Enter the short code for the project, such as ABCO000001.

Selected (Optional) Select to use the current blocklist for the project.

4. Click OK.

The new remote blocklist is displayed in the project terminology list.

Open and edit a local blocklist

You can open and edit local blocklist entries at any time after blocklist creation.



G You cannot open a remote blocklist in Wordfast Pro.

To open and edit a local blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select a local blocklist, and select Open
Blocklist.
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3. On the Blocklist Editor tab, view the blocklist terms for both source and target languages. You can also filter,
add, remove, and update terms.

(=] Werdfast Pro - Blocklist Editor - ]
Blockdisl Editor

x

M >~ o xBb & & @& &
Maad Pravious Cui Copy Pacte Add Term Remave Term Impart Export
Updata Undats Blocklist Blockdst
1 | Please click Click
Search: |
Farbidden - . - -
2 | Organisation Organization
Tarm Text
Enles Temn Texd
ﬁ 3 | Waming popup Warning message
—F
3=
4 OFnd X Clear .

4. (Optional) To search for source or target blocklist terms, enter your search criteria in the appropriate fields in
the Filters sidebar, then select Find.

You can make your filtered search case-sensitive or specify an exact match, then filter
further by creator, user, and modification date.

5. (Optional) To reset your search criteria, select Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit entries within the forbidden
and suggested term columns.



Import a local blocklist

To use a local blocklist from another source, use the Import Blocklist action.
To import a local blocklist:
1. In the Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select Import Blocklist.
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3. On the Import Blocklist dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Blocklist x
W Import Blocklist
File Type" Txt -
Import File:™ CAlsers'\Documents\Source\de-DE Termide-DE_Te Browse...

#) Create a new blocklist

0K Cancel

Field Action
File Type Select TXT as the file format for importing raw text files.
Import File Select Browse to locate and select an Import File.

Create a new blocklist Select to use the imported blocklist to create a new blocklist, rather than add
terms to an existing blocklist.




Field Action

Import into existing Select to use the imported blocklist to add to the selected blocklist.

blocklist

Existing Blocklist Select from the drop-down list to append the imported blocklist to an existing
blocklist file.

If term already exists Select from the drop-down list to import the term into an existing blocklist file.

e Add as a new term — Add the term to the existing blocklist file.

¢ Do not overwrite — Ignore the term and retain the term already in the
blocklist file.

e Overwrite existing term — Use the new term to replace the term already
in the blocklist file.

Delete all terms from Select to delete the existing term and replace it with the new blocklist term.
existing Blocklist

4. Select OK.

The blocklist is imported and displayed in the project Blocklist.

Export a local blocklist

To share a local blocklist with another linguist, use the Export Blocklist action.

To export a local blocklist:

1. In the Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a blocklist from the project Blocklist.

3. Select Export Blocklist on the Project Terminology tab.
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4. On the Export Blocklist dialog, choose a blocklist name, export type, and folder location for the blocklist
export file.

o Required fields are marked with a red asterisk.

Blockhst:* Blocklrst -
Export Type:” Txd v
File Locaton:” Browse...
oK Cancel

Blocklist Select a blocklist from the drop-down list.
Export Type Select the export file type from the drop-down list.
File Location Browse and select the folder location for the export file.

5. Select OK.

The selected blocklist exports to the selected folder location.

Modify a glossary or blocklist

To modify a glossary or blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.
2. In the Current Project view, on the Project Terminology tab, select a glossary or blockilist.

3. Select Modify.
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4. On the Create Glossary dialog, modify the details as required. Based on your selection, other fields auto-

populate.

0 Required fields are marked with a red asterisk.

Modify Glossary x
W Modify Glossary

Name:* [Geman Giossan;

B se
] Selected
Read-only
0OK Cancel
Name Modify the name of the current glossary or blocklist.
Selected (Optional) Select to use the current glossary or blocklist for modification.
Read Only (Optional) Select to leverage the glossary or blocklist without updating it with the new
translation.
5. Select OK.

Your modifications are saved.

Remove a glossary or blocklist

When you remove a glossary or blocklist from a project, the glossary or blocklist file remains in the glossary or
blocklist folder on your computer. You can add it again with the Add Local or Connect to Remote action.

To remove a glossary or blocklist:
1. In the Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a glossary or blocklist.



3. Select Remove.
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A warning message asks you to agree to the removal.
4. Select Yes.

The selected glossary or blocklist is removed from the project terminology list.



13. Monitor reports

Use the Reports tab to open and to export auto-generated analysis and cleanup reports to .CSV, .HTML, .XLS,
and .PDF formats.
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Open a report
Use the Open Report action to open and view an auto-generated report.

To open a report:

1. Inthe Current Project view, on the Reports tab, select a report.



2. Double-click the report file name.

FY

Primary TM: tms://stg-supportl.com/TMS?
tm=DOC000003/MARDDD003&usr=Mar-en-
Secondary TM:
file://C:\Users\Laks\Desktop \LNK\WF\WF
testingDoc_TM1

H summary
Match Types Segments Words Percent Tags
Leveraged 70 372 99 &
Repetitions 2 2 1 0
TM Matches
Context & &0 16 5]
100% 54 312 83 0
95%-99% 0 0 0 0
85%-94% 0 0 0 0
75%-84% 0 0 0 0
50%-74% 0 0 0 0
No Match 2 2 1 0
Ignored 0 0 0 0
Total 74 376 100 B
Chars/Word 6.46
Chars Total 2430

H c:\Users\Laks\Wordfast4\ projects\Document
ation2\ de\txIf\Sample_1.docx1.txml.txIf

H c:\Users\ Laks\Wordfast4\ projects\Document
ation2\ de\ xlf\Sample_3.docx.baml.txlf

0K

3. Review the report, then select OK to close the dialog.

Export a report

You can export an auto-generated report to a CSV, HTML, XLS, or PDF file format before you view it.
To export a report:
1. On the Reports tab, select a report.

2. Select a format from the Export drop-down list.

Project Files

Project TM Project Terminology

3. Browse to the location for the report, enter a file name, and select Save.

The report is saved to the designated location.



14. Manage project reference files

You can include reference files in a project to provide context. Typical reference files are additional instructions,
illustrations, workflow diagrams, certifications, or any file that might aid translators and reviewers. Reference files
remain untranslated.

0 Users cannot modify reference files once you attach them to the project.
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Add reference files

To add reference files:

=

In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Reference Files tab, select Add Files.
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3. On the Open dialog, browse and select the reference file. To select multiple reference files, press Ctrl and
select them.

4. Select Open.

The files are added to the reference files list for the project.



Open a reference file

To open a reference file:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. In the Current Project view, on the Reference Files tab, select a reference file from the list.

3. Select Open File.
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The selected file is opened.

View submission instructions

Submitters can include instructions as part o